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Preface

This guide provides step-by-step procedures for configuring and administering Documentum
Content Transformation Services products. This manual also includes some information about
modifying plug-ins to extend the functionality of Content Transformation Services products.

This manual assumes that your Content Transformation Services product(s) is/are successfully
installed. For information on installing your Content Transformation Services product(s), refer to the
installation guide for your product.

The following documents are available for the Content Transformation Services product suite:

• Release Notes: Includes important notes on installation and administration issues, requirements.
These documents also references some known problems, limitations, and problems fixed in that
release. The following Release Notes documents are available:
— Document Transformation Services Release Notes

— Advanced Document Transformation Services Release Notes

— XML Transformation Services Release Notes

— Media Transformation Services Release Notes

— Audio/Video Transformation Services Release Notes

• Content Transformation Services Transformation Suite Installation Guide: Describes each product’s
typical installation and capabilities, how to install your Content Transformation Services product,
and how to configure repositories with the product. Also includes instruction for installing and
configuring your product with the CTS Activity Template and CTS WebServices.

• Content Transformation Services Profile Modification Guide: Provides instructions for modifying
profiles used by Documentum Content Transformation Services products.

• Content Transformation Services Product Development Guide: Explains how to use the plug-in SDK
to create and configure your own plug-ins for Content Transformation Services products.
Contact your account representative for availability of the Content Transformation Services Product
Development Guide

Intended audience
This manual is intended for the person who is responsible for configuring and administering Content
Transformation Services products, generally known as the system operator or system administrator.

It is assumed that the system operator has a basic understanding of the Windows operating system.

EMC Documentum Content Transformation Services Transformation Suite Version 6.7 Administration Guide 9
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Revision history
The following changes have been made to this document.

Revision history

Revision date Description

April 2011 Initial publication.
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Chapter 1
Content Transformation Services
Overview

This chapter provides an overview of Content Transformation Services products. It includes the
following sections:
• What is Content Transformation Services?, page 11

• Content Transformation Services transformations, page 14

What is Content Transformation Services?
Content Transformation Services (CTS) is a suite of Documentum server products that perform
transformations and analysis on repository content. CTS includes these products:

• Document Transformation Services (DTS)

• Advanced Document Transformation Services (ADTS)

• Media Transformation Services (MTS)

• Audio/Video Transformation Services (AVTS)

• XML Transformation Services (XTS)

How Content Transformation Services products work

Content Transformation Services products integrate with Documentum Content Server to process,
store, and manage files within the Documentum schema. When users import files or request file
transformations, the Content Server stores those transformation requests in a queue. The Content
Transformation Services products will poll that queue intermittently, looking for register and request
objects that they can handle. The file is then passed to the appropriate Transformation Service plug-in
for processing.

When the processing is complete, the Content Transformation Services product server updates the
original objects with new renditions or creates the new objects, as requested. The objects are saved to
the repository and the requests are removed from the queue. The objects are then ready for use.

EMC Documentum Content Transformation Services Transformation Suite Version 6.7 Administration Guide 11



Content Transformation Services Overview

Content Transformation Services products connect to Content Server and are available to all
applications and clients that are built on top of the Documentum Foundation Classes (DFC), as
shown in Figure 1, page 12.

Figure 1. The position of Content Transformation Services products in the Documentum product stack

When users import files, Content Server recognizes file formats that are supported by your Content
Transformation Services products through the richmedia_enabled attribute of the dm_format object,
and adds those requests to a queue.

Content Server adds all queues requests (dmi_queue_item objects) to the dm_mediaserver queue for
Content Transformation Services. The Content Transformation Services products regularly poll the
queue, looking for requests.

Each item in the queue has a priority. Content Transformation Services handles requests on a
priority-based, first-come-first-served basis. For example, when a media file is checked in, the
thumbnail request is handled at normal priority. An urgent request, perhaps for a transformation for
which the user is waiting, can be submitted at high priority, which causes the request to be handled
before any lower priority request. A batch check-in of many files can be set to a lower priority to
avoid hampering the performance of more urgent media operations. When requests have equal
priority, Content Transformation Services first handles the request that was submitted first.

Each request is analyzed and the file is then passed to the appropriate media plug-in for processing.
The Content Transformation Services plug-ins extract properties and generate thumbnails,
low-resolution renditions, storyboards, if applicable, and perform transformations, if requested.

When the processing is complete, the Content Transformation Services products update the original
object with new renditions or create the new objects, as requested. The objects are saved to the
repository (see Storing objects, page 13) and the request is removed from the queue. The objects
are then ready for use.

Users browse metadata for the objects and view thumbnails and low-resolution renditions in a
Content Transformation Services enabled Documentum client application, such as Digital Asset
Manager, Web Publisher, Media WorkSpace, and CenterStage.

Applications on the Documentum platform determine whether some Content Transformation Services
products are installed on the system by examining the value of a global flag, the richmedia_enabled
attribute of the dm_repository_config object. The global flag attribute, richmedia_enabled, is set to
TRUE automatically the first time an applicable Content Transformation Services product is started.

12 EMC Documentum Content Transformation Services Transformation Suite Version 6.7 Administration Guide
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Content Transformation Services Overview

Applications will test this object, dm_repository_config, when a user logs in to a repository. When an
application detects the flag, it recognizes that a Content Transformation Services product is installed
and the system is able to process files.

The Content Server stores thumbnails in a special file store that is shared with the Thumbnail Server,
a server that uses Java servlets to manage thumbnail representations and HTTP technology to
accelerate the display of thumbnail images in Web client applications.

For more information on Thumbnail Server, see the Thumbnail Server Release Notes.

With Streaming Server integration, when a streaming media object is checked into the repository,
the Content Server recognizes that the object is in a streaming format and figures out how the object
should be processed and where it should be stored. The Content Server stores the streaming media in
a separate file store from which the media can be streamed directly to the client.

For more information on Streaming Server integration, see the Audio/Video Transformation Services
Release Notes, or consult your Streaming Server documentation.

Storing objects

Storage rules are generally controlled by the Content Server. All objects have multiple content objects
that are each stored in databases on the repository. For more information on object storage, see the
Content Server Administration Guide.

The following section briefly describes where and how Documentum objects, including all files that
are produced by Content Transformation Services, are stored.

Media Object data model

The information in Figure 2, page 14 demonstrates how thumbnails, low-resolution renditions, media
properties, and transformations are stored in the repository for objects.

Each box represents an object in the repository. The parent, Media Object, can have one or more of
the renditions specified in the boxes. Each rendition has its own media properties stored in the
repository. For example, a JPEG thumbnail rendition of the object will have the media properties
cont_attr_name and cont_attr_value associated with it.

EMC Documentum Content Transformation Services Transformation Suite Version 6.7 Administration Guide 13



Content Transformation Services Overview

Figure 2. Media Object data model

Content Transformation Services
transformations
Transforming is the act of changing a file in some way to create a new file.

Transformations take place either as part of the registration process (described in Automated
transformations, page 14) or as requested by users (described in User transformations, page 19).

The following examples illustrate how Content Transformation Services products transform files
from one format to another, using examples from specific Content Transformation Services products.

Automated transformations

The process of adding files to the repository is called registration. When files are imported or checked
in, default transformations are created automatically.
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Content Transformation Services Overview

The overall process of registering a file in a Content Transformation Services product (depicted in
Figure 3, page 16) is as follows:
1. A user imports or checks in a file to the repository.

2. Content Server creates a dmi_queue_item object of the event type dm_register_asset, which is
added to the queue. Only content that is rich media enabled is passed to the queue.

3. The server checks the queue regularly; the default is every 10 seconds. When it finds queue items,
it signs off a certain number (the default is 10 items). Both of these parameters are configurable
through Documentum Administrator (see Chapter 2, Administering and Configuring Content
Transformation Services Products Through Documentum Administrator for more information).

4. The server starts processing the items using the register profile. It will not remove an item from
the queue until the transformation is complete or has failed.

5. The server loads the transformation profile specified by the inner profile path in the register
profile.

6. The server polls the plug-ins in the order specified by the transformation profile.

7. The server finds a plug-in to accept the transformation. If more than one plug-in can handle the
transformation, the plug-ins are invoked in the order specified by the transformation profile.

8. The server uses the command-line file to perform the transformation with the relevant plug-in.

9. The server updates the object in the repository, storing the thumbnails and low-resolution
renditions (by using a DFC call) and storing media properties as attributes for each rendition
(in the attributes content_attr_name and content_attr_value of dmr_content objects). It removes
the dmi_queue item object from the queue.

10. The new object or renditions are available in the client application.

EMC Documentum Content Transformation Services Transformation Suite Version 6.7 Administration Guide 15
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Content Transformation Services Overview

Figure 3. The registration process

The automatic transformation processes performed by some Content Transformation Services
products are described in more detail in the following sections:

• Generating thumbnails, page 16

• Generating storyboards, page 17

• Generating low-resolution renditions, page 17

• Extracting media properties, page 18

• Extracting XMP metadata, page 18

• Extracting IPTC headers, page 19

For more information about the storage of files, see Storing objects, page 13.

Generating thumbnails

A thumbnail is an image that is used to represent an object in client applications. Thumbnails provide
a visual cue for browsing media and enable users to identify objects quickly.

Some Content Transformation Services products automatically generate a thumbnail for each object
by passing the object to the appropriate plug-in. The plug-in extracts the object’s properties and
creates a new object by transforming the original object into a predefined thumbnail format (for
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Content Transformation Services Overview

example, a JPEG that is 100 x 100 pixels). The Content Transformation Services product sends the
thumbnail back to Content Server as a rendition of the original object. The thumbnail’s media
properties are saved as attributes of that rendition.

Content Server stores thumbnails in a special file store that is shared with the Thumbnail Server, a
dedicated server that delivers thumbnails directly to the browser. For more information about the
Thumbnail Server, refer to the Thumbnail Server Release Notes.

Generating storyboards

Storyboards are low-resolution — and low-bandwidth — representations of video (with the
installation of Audio/Video Transformation Services) or multi-page objects (for example, PDFs),
displayed as a sequence of JPEG thumbnails. Storyboards are generated automatically during
registration (import or check in) of applicable file types.

For some video storyboards, each frame may include timecode information. The timecode is stored
as a property of each JPEG image content object in the storyboard.

For more information on which video formats are supported with a Streaming Server, see the
Audio/Video Transformation Services Release Notes.

For multi-page documents such as PowerPoint presentations, the storyboard contains a thumbnail
of each slide in the presentation. Selecting one frame of an object’s storyboard will display that
frame in its related application as a JPEG image.

Storyboards are stored as renditions of the original dm_document object. Each JPEG image that
makes up a storyboard is stored in an administrator-specified location. For more information on
storage of objects, see the Content Server Administration Guide.

Generating low-resolution renditions

Low-resolution renditions are used to represent high-resolution objects. Low-resolution renditions
are used by the client applications when a user wants to preview a high-resolution media file. Due
to its smaller file size, a low-resolution rendition can be displayed more quickly than a file in its
original format.

Media Transformation Server automatically generates low-resolution renditions for supported files
upon registration. When the object is checked in, Media Transformation Server automatically invokes
the appropriate plug-in to generate the rendition according to a predefined profile. For example,
Media Transformation Server might generate a full-sized JPEG representation of the image, reduce it
to a predetermined width and height, and save it back to the repository as a low-resolution rendition
of the original object. Its media properties are stored as attributes of the rendition. Low resolution
renditions are stored in a location that is determined by the Content Server.

EMC Documentum Content Transformation Services Transformation Suite Version 6.7 Administration Guide 17
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Extracting media properties

Content Transformation Services provides a range of plug-ins to support industry-standard file types.
Some plug-ins recognize files and automatically extract media-specific properties, such as image
height and width, bit rate, and audio sampling frequency.

During registration, the Content Transformation Services product first generates media properties for
the high-resolution object. It then stores the properties for the object in two repeating attributes of
dmr_content objects: content_attr_name and content_attr_value.

Media properties are added to the object’s indexed metadata (as a string value) and saved back to the
repository. This provides the framework for client applications to expose media properties as part of
an object’s searchable metadata set. The Content Transformation Services product does the same for
each rendition (thumbnail, low-resolution, and transcoded renditions).

A sample of media properties extracted by Media Transformation Services and Audio/Video
Transformation Services for image, video, and audio files can be found in Table 1, page 18.

Table 1. Sample extracted media properties for Media Transformation Services and Audio/Video
Transformation Services

Image Video* Audio*

Width Frame width Sample width

JPEG quality Bit rate Sample rate

Compression Frame rate Number of samples

Format Format Format

GIF interleave Number of frames Number of frames

Color mode Frame height Number of channels

Height Duration Duration

* Video and Audio property extraction is available only with the add-on component Audio/Video
Transformation Services.

Extracting XMP metadata

Adobe’s Extensible Metadata Platform (XMP) embeds metadata (such as descriptions, titles,
keywords, author, and copyright information), into the file itself. In XMP-enabled applications,
metadata is captured during the creation process and embedded in the file.

Media Transformation Services and Advanced Document Transformation Services have the ability to
extract XMP metadata from supported formats upon import. Media Transformation Services and
Advanced Document Transformation Services can write XMP metadata to those same file formats

18 EMC Documentum Content Transformation Services Transformation Suite Version 6.7 Administration Guide
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Content Transformation Services Overview

Extracting IPTC headers

An IPTC header is a form of embedded metadata stored within an image (added to an image through
an application such as Adobe Photoshop). It is the standard, defined by the International Press
and Telecommunications Council (IPTC), for use in images that are passed over news wires. IPTC
headers can contain a variety of details and descriptive information, including copyright information,
photo credits, caption text, and shot locations.

Media Transformation Services supports a special transformation for extracting IPTC headers. Media
Transformation Server can extract IPTC header information from image files (PSD, PNG, GIF, and
JPEG formats) and store the information as an XML rendition of the media object. The extraction is
modeled as a transformation of the object based on an IPTC profile.

Once the header information is available in an XML format (and is part of the image record in the
repository), the information in the XML file can be used by applications. For example, the copyright
and photo credit can be published to the web site when the image is used.

To view the IPTC headers for an image, you must view an image’s renditions page, and open the
XML rendition that contains the header information.

User transformations

User requests are processed similarly to register requests. The main exception is that processing is
not automatic. A user must invoke a request for transformation.

The transformation process (depicted in Figure 4, page 20) is as follows:

1. The Documentum application (such as Digital Asset Manager) gets a list of available profiles and
their required parameters by reading special system objects in the repository.

2. The user requests a transformation for an object by selecting a profile and entering parameters
(if the profile requires parameters).

3. The application creates a transformation (TRANSCODE_CONTENT) request.

4. Content Server creates a queue object that requests the transformation. The request contains the
profile ID, any parameter values required for a given operation (for example, height and width or
angle of rotation), and the source and target formats.

5. The server polls the queue, finds objects for transformation, and matches the requested profile
and source format to a particular plug-in.

6. The server locates the XML command-line file for the profile, substitutes parameters as required,
and invokes the plug-in to perform the transformation according to the selected profile and
parameters.

The transformation occurs in the background.

7. When the transformation is complete, the server sends the transformed media back to Content
Server and updates the original object with the new rendition and its associated media properties,
which are stored as attributes of the rendition.

8. The server removes the transformation request item from the queue.

EMC Documentum Content Transformation Services Transformation Suite Version 6.7 Administration Guide 19
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Content Transformation Services Overview

Figure 4. The transformation process

User transformation profiles

Content Transformation Services products provides a set of predefined profiles for most common
operations and allows administrators to extend or combine profiles and create new profiles to meet
their specific requirements. The following are examples of some profiles a Media Transformation
Services administrator might create:
• Create small JPEG could resize an image to fit within 200 x 500 pixels and save it as a JPEG rendition.

• Resize H x W JPEG could resize an image to a specified height and width and save it as a JPEG
rendition

• Add text layer GIF could add a predefined text layer to an image and save it as a GIF rendition.
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Chapter 2
Administering and Configuring Content
Transformation Services Products
Through Documentum Administrator

Many administration and configuration tasks for Content Transformation Services products can be
performed using the CTS Administration component of Documentum Administrator. You must have
access to Documentum Administrator and the repositories to which your Content Transformation
Services products are configured.

The CTS Administration component appears in Documentum Administrator if at least one instance is
installed and configured on a repository to which it is connected. This check is done through executing
the DQL/DFC call to find the presence of at least one cts_instance_info object in the repository.

The following Content Transformation Services configuration and administration tasks can be
performed through Documentum Administrator client, in the CTS Administration Node:
• Change the user for repository login

• Change the polling interval— The polling interval is the amount of time in seconds that the
instance will wait between polls.

When document processing (transformation) is requested, Content Server creates queue items
and appends them to the dm_mediaserver queue or dm_autorender_win31 queue, depending on
the type of request. Content Transformation Services products use a queue polling mechanism to
look for items in the queue to process. When a Content Transformation Services product finds
items in any of these queues, it proceeds with processing.

• Change the logging level— The logging level value controls how much information will be
recorded in the CTS log files, which the product uses. Log files can be used to troubleshoot
the system.

• Change the system operator user— The system operator is the name of the user who receives
messages from an instance of a Content Transformation Services product.

If a Content Transformation Services product fails to process a particular item, it queues an event
(dm_mediaserver_error) to the Inbox of the repository user who is defined as the system operator
(sysOpUser). The event appears as an error message in the sysOpUser’s Inbox.

• Change the system notification setting— The notification setting controls whether success
notifications should be sent to each individual user requesting a transformation through a CTS
product.
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• Change the maximum number of queue items— This value controls how many items the
Content Transformation Services instance adds for processing each time it polls the queue.

• Change the queue item expiry—This value controls the amount of time an item will be sitting on
a queue before being deleted from the queue.

• Change your password— This task can be done through Documentum Administrator.
Alternatively this task can be done using the setPassword utility. Note that the system
administrator must also change the password on the server. See 3.5 Changing the CTS administrator
password.

• View log files—Log files are created for each plug-in. The contents and detail level of each log file
depend on the log file setting you have chosen for the Content Transformation Services instance.

• View details of an instance— Details include each CTS product that is configured for a
repository, the version number of each product, the name of the host machine for each product, its
current status (running or stopped), the time it was last started, the number of queued items for
the instance, and the number of items processed by the instance.

• Control a CTS instance— This includes starting, stopping, and refreshing an instance. Note
that performing any of these actions will apply to all CTS products running on the host. This is
because all CTS products on a host use the same CTS Windows service. Starting and stopping
CTS Windows service can also be done manually, on the host machine. See Starting and stopping
Content Transformation Services products, page 26.

The Documentum Administrator User Guide provides more information about these administration
tasks.

Starting and stopping the CTS Administration
Agent
In order to use the Content Transformation Services Administration component in Documentum
Administrator, it is necessary to have the CTS Admin Agent running on the CTS host machine. The
Admin Agent can be controlled either from the Windows Start menu or by running a batch file.

To start/stop the CTS Admin Agent through the Start menu:

1. Log in to the Media Transformation Services host.

2. Go to the Windows Services utility located at Start > Settings > Control Panel > Administrative
Tools > Services.

3. Select Documentum CTS Admin Agent.

4. To start the Admin Agent, click Start.
To stop the Admin Agent, click Stop.

To start/stop the CTS Admin Agent by running the batch file:

1. Log in to the Media Transformation Services host.

2. Navigate to C:\Program Files\Documentum\CTS\Admin Agent\bin.
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3. To start the Admin Agent, run the startup.bat file.
To stop the Admin Agent, run the shutdown.bat file.
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Chapter 3
Common Configuration and
Administration Tasks and Tips

This chapter contains configuration and administration tasks that are common to all Content
Transformation Services products. Many configuration and administration tasks are performed
through Documentum Administrator.

The following sections are included in this chapter:
• Starting and stopping Content Transformation Services products, page 26

• Adding or removing repositories serviced by Content Transformation Services products, page 26

• Defining file formats and DOS extensions, page 26

• Configuring Inbox notifications, page 27

• Changing the CTS Service user after installation, page 29

• Configuring multiple domains for CTS, page 30

• Changing the CTS administrator password, page 31

• Using the CTS Reporting Tool, page 31

• Managing the transformation queue, page 33

• Configuring the queue pre-processor mechanism to manage queue item sign-off, page 37

• Controlling how quickly programs time out, page 37

• Caching CTS capabilities on startup, page 39

• CTS requires its own log4j.properties files, page 39

• Setting logging appenders, page 40

• Enabling performance and throughput logging, page 41

• Processing requests for local content, page 41

• Configuring CTS for Branch Office Caching Services, page 41

• Configuring queue management for BOCS installations, page 43

• Load balancing servers, page 44

• Configuring CTS Server to run in SSL Mode, page 45

• Using a profile description bigger than 192 bytes, page 46
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• Automating thumbnail/proxy creation for custom formats derived from an existing
rich_media_enabled supported CTS dm_format, page 46

• Performing bulk transformation requests for documents, page 47

Starting and stopping Content Transformation
Services products
When you restart the Content Transformation Services host, the CTS server will start automatically.
You may also start and stop Content Transformation Services products manually, using the following
procedure. This may be necessary after modifying a transformation profile, for example.

To start/stop a Content Transformation Services product:

1. Log in to the Content Transformation Services product host.

2. Go to the Windows services utility located at Start > Settings > Control Panel > Administrative
Tools > Services.

3. Select Documentum Content Transformation Services.

4. To start the product, click Start.
To stop the product, click Stop.

Note: A background service, called Documentum Content Transformation Monitor Services, restarts
the Content Transformation Services product if it stops unexpectedly. Since the monitor is set to run
automatically by default, you will not typically need to access it. It is located underWindows Services.

Adding or removing repositories serviced by
Content Transformation Services products
During installation, Content Transformation Services products are configured to communicate with
single or multiple repositories. You can add or remove a repository by running the Configurator
(accessible through the Windows Start menu. For information on the Configurator and how to run it,
see the Content Transformation Services Transformation Suite Installation Guide.

Note: You must have SuperUser privileges for a repository in order to add or remove support for a
Content Transformation Services product.

Defining file formats and DOS extensions
You must define file formats and DOS file extension pairs in the repository for all source document
types that you want your Content Transformation Services product to recognize that are not standard,
out of the box pairs. In addition, if the DOS file extension differs from the Documentum format
name, you must update the FormatMapperService.xml config file on your Content Transformation
Services product host.
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Refer to the Documentum Administrator User Guide, Chapter "Formats” for information and procedures
to add file formats to your system.

The following procedure is required only if the DOS file format differs from the Documentum
format name in Content Server. Table 2, page 27 lists some examples of the format mapping used in
Documentum systems. Use these format names in DQL.

Table 2. Documentum format mapping

Format Documentum name

Bitmap image (BMP) bmp

Encapsulated PostScript (EPS) eps

GIF image gif

JPEG image jpg

TIFF image tif

To update the FormatMapperService config file:

1. Navigate to %CTS_HOME%\config.

2. Open the FormatMapperService.xml file in a text editor.

3. Add the format to the <CTSHandlerList> section, using the following syntax:
<FormatMapper CTSFormat="<dos extension>" DocumentumFormat="<format
name in Content Server>"/>

For example, the entry for JPEG files is:
<FormatMapper CTSFormat="jpeg" DocumentumFormat="jpg"/>

4. Save and close the FormatMapperService.xml file.

Configuring Inbox notifications
When transformation requests fail, the Content Transformation Services product server sends
notifications to the Inbox of the repository user. By default, success notifications are not sent.
However, these default behaviors can be configured using the procedures in this section.

The behavior of success and failure notifications differs slightly. While success notifications can be
suppressed for all users, failure notifications are sent to admin users regardless of the setting. Table
3, page 27 outlines these behaviors.

Table 3. Inbox notification settings

Notification Setting User(s) notified

Success Yes Regular user

No none
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Notification Setting User(s) notified

Failure Yes Regular user and admin user

No Admin user

There are two levels of Notification configuration options:
• Configuring the CTSServerService.xml file. See the procedures below for configuring the file.

• Users can explicitly choose the Inbox Notification option through their client (for example, Digital
Asset Manager) when sending a transformation request. This is applicable only for regular queue
items and not for legacy queue items.

To modify the configuration of success notifications:

1. Navigate to %CTS_HOME%\config.

2. Open the CTSServerService.xml file in a text editor.

3. To turn on notifications for successful transformations, you need to set the notifySuccessMessage
parameter to the following:
<CTSServer AttributeName="notifySuccessMessage" AttributeValue="YES"/>

To turn off notifications for successful transformations, you need to set the notifySuccessMessage
parameter to the following:
<CTSServer AttributeName="notifySuccessMessage" AttributeValue="NO"/>

Note: There are two <QueueProcessorContext> tags for each repository that is configured. You
must modify the notifySuccessMessage parameter within each <QueueProcessorContext> tag.

4. Save and close the CTSServerService.xml file.

To modify the configuration of failure notifications:

1. Navigate to %CTS_HOME%\config.

2. Open the CTSServerService.xml file in a text editor.

3. To turn on notifications for failure transformations, you need to set the notifySuccessMessage
parameter to the following:
<CTSServer AttributeName="notifyFailureMessage" AttributeValue="YES"/>

To turn off notifications for failure transformations, you need to set the notifySuccessMessage
parameter to the following:
<CTSServer AttributeName="notifyFailureMessage" AttributeValue="NO"/>

Note: There are two <QueueProcessorContext> tags for each repository that is configured. You
must modify the notifySuccessMessage parameter within each <QueueProcessorContext> tag.

4. Save and close the CTSServerService.xml file.
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Inbox notification behavior

Content Transformation Services products behave differently for legacy and regular queue items.
The following table details the behavior for administrative and regular users based on the type of
queue item and notification options selected.

Table 4. Inbox notification behavior for admin and regular users

Legacy calls (dm_autorender_win31 queue items)

Admin user Will not be notified.Success Notification

Regular user Will be notified based on the
entry in CTSServerService.xml
for ‘notifySuccessMessage’.

Admin userFailure Notification

Regular user

Both Admin user and
Regular user will be notified
based on the entry in
CTSServerService.xml for
‘notifyFailureMessage’.

Regular Queues ( dm_mediaserver queue items)

Admin user Will be notified if
‘notifySuccessMessage’ is
set to ‘Yes’ and at the same
time if Regular user has not
requested it through the client
interface.

Success Notification

Regular user Will be notified based on
the value given in the
client interface during the
transformation request.

Admin user Will be notified based on the
entry in CTSServerService.xml
for ‘notifyFailureMessage’.

Failure Notification

Regular user Will be notified based on
the value given in the
client interface during the
transformation request.

Changing the CTS Service user after
installation
In certain situations, it may be desirable to change the CTS Service user account after a Content
Transformation Services product has been installed and configured. This may be necessary for
security reasons, for example.
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It is not necessary to uninstall and reinstall the Content Transformation Services product to make
this change. Simply ensure that the new user has full COM access permissions for any rendering
software (for example, Microsoft PowerPoint and AFPL Ghostscript being used by the Content
Transformation Services product).

Configuring multiple domains for CTS
The multiple domains feature processes user requests to multiple domains. This feature is enabled
only if the repository is already in domain-required mode and the CTS being configured is at least
version 6.5 SP1. The following procedure is completed using Documentum Administrator:

To configure users for multiple domains:

1. Connect to the repository that is CTS instance configured.

2. Click the Administration node.

3. Click the Content Transformation Services node.

4. Click the CTS Instances node.

5. Select the CTS instance from the list of available instances.

6. Click Tools>Content Transformation Services>Configure>Users.

7. The CTS Administrative Users page displays a list with pre-configured administrative users and
their domains for the selected CTS instance. Click Add.
The Content Transformations Services User Details page displays.

8. Select the desired super user from the drop down list (the required dm_user should already be
added to the repository).

9. Enter the correct password.

10. Enter the correct domain.

11. Click OK to return to the CTS Administrative Users page.

12. Select OK to save the changes.

To change the password of an existing domain user configuration:

1. From the CTS Administrative Users page, select the required domain user. Click Edit.
The Content Transformations Services User Details page displays with the password fields
enabled.

2. Enter the new password.

3. Click OK to return to the CTS Administrative Users page.

4. Select OK to save the changes.

To remove a domain user configuration:

1. From the CTS Administrative Users page, select the domain user configuration you want to
remove. Click Delete.

30 EMC Documentum Content Transformation Services Transformation Suite Version 6.7 Administration Guide



Common Configuration and Administration Tasks and Tips

2. Select OK to save the changes.

Changing the CTS administrator password
You can change the CTS administrator’s password by running the setPassword utility. The password
also must be changed on Content Server.

To change the administrator’s password:

1. Stop Content Transformation Services.

2. Change the password on the Content Server.

3. Open a command prompt window.

4. Enter the following command:
> cd %CTS%\docbase\<repository name>\CTSServerScript\bin
> setPassword <new_password>

5. Restart Content Transformation Services.

Note: It is also possible to change the password in Documentum Administrator instead of running
the setPassword utility.

Using the CTS Reporting Tool
The CTS Reporting Tool provides detailed information about transformation type, volume and
error events. Data such as CTS product performance, plug-in usage, and requests by users assists
in monitoring and analyzing transformation usage and can assist with load balancing strategies.
Reporting can be logged for a configurable time frame and then rolled over to be archived. The
resulting information is retained in the repository and is viewable as a CSV formatted file (a report
format using comma-separated values) through Digital Asset Manager. Users can view their own
CTS reporting data. Administrators have access to all data.

Usage tracking is configured in Documentum Administrator. The CTS Reporting Tool reports on the
number of requests in a given time frame according to the following options:

• Number of successful transformations

• Number of requests that could not be handled

• Cumulative error report

• Number of errors per format and per specific transformation request

• Cumulative total file sizes of input and output per given time frame

• Total requests per specific user
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Enabling and disabling the CTS Reporting Tool

The CTS Reporting Tool is turned off by default. Usage tracking can be switched on or off.

To enable/disable the CTS Reporting Tool:

1. Login to Documentum Administrator.

2. In the tree pane, select Transformation Services>CTS Reporting Configuration

3. Select the following:
• Reporting Configuration (ON/OFF) check box, to select whether the data is collected or not.

• Purging Configuration (ON/OFF) option, to delete any data collected.

• Archiving Configuration (ON/OFF) option, to select whether data should be archived.

4. If you have enabled Reporting Configuration and Archiving Configuration, provide the
information for the following fields.
• (Number of days) Archiving Interval to set how often the report should be archived —
everyday, every two days, and so on.

• (Size of transformation request table) Archiving DataSize, to set the number of transformations
that should be recorded at a time before the data is archived and for the compilation to start
again.

• (Archiving monitor interval in seconds) Archiving Monitor Interval, to set the length of time
in seconds the report should be updated.

5. Click OK.

Viewing the CTS Reporting Tool report

When the CTS Reporting Tool is enabled, the following information is recorded for each
transformation request:

• The object id of the source document

• The object id of the queue item

• The user name who sends the requests

• The format of the source document SOURCE_FORMAT = "source_format"

• The format of target TARGET_FORMAT = "target_format"

• The transformation type, it could be either user created or auto/import

• The profile name used for the transformation request

• The target object type, it could be rendition or related object

• The parameters send in the request

• The queue item added time

• The queue item signed off time
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• The transformation completed time

• The source file size

• The target file size

• The status, it could be SUCCESS, FAILED, or UNHANDLED

• The CTS instance doing the transformation

• Any message resulting from a transformation execution.

To view the CTS Reporting Tool report:

1. In Digital Asset Manager, go to Tools>Transformation report>View

2. The CTS Transformation Report page displays. Enter the information for the following fields:
• Report name

• Start date

• End date

3. Click OK.

4. The Select Folder screen appears. Select the destination folder to save the retrieved report. Click
OK. A CSV report opens with the requested information.

Managing the transformation queue
The Queue Management feature provides a mechanism for monitoring and administrating
transformation request queues. This feature allows users to view or delete their own pending
transformation requests. Administrators can manage the queues for all users and change the priority
of transformation requests when required.

The Queue Management feature is accessed through the Transformation node in Digital Asset
Manager.

Administrators can manage the queue by deleting items or changing the priority of items. Users can
view their own transformation requests and delete their own transformation requests, but cannot
change a queue item priority.

• Viewing transformation requests in the queue, page 34

• Changing a queue item’s priority, page 34

• Viewing details of a queue item, page 35

• Deleting a pending queue item, page 35

• Configuring additional queue management fields, page 36

• Removing a queue management field, page 36
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Viewing transformation requests in the queue

Users can monitor the status of their transformation requests by viewing the queue. If a user is
dissatisfied with the priority level of their transformation request(s), they can ask their administrator
to change an item’s priority on their behalf.

To view transformation requests in the queue:

1. Login to Digital Asset Manager.

2. In the tree view on the left side of the screen, select the Transformations node. Click on the
Transformations link. The right pane will refresh with a list of current queue items.
Transformation requests are displayed in priority order. The priority level of an item is indicated
as follows:

• denotes a high priority item

• denotes a medium priority item.

• denotes a low priority item.

3. For administrators only: Choose the items to view by selecting an option from the Show list
box in the top right corner:
• Show All displays all users transformation requests.

• Show Mine displays only your transformation requests.

4. To sort transformation requests in ascending or descending order, click the header field on each
of the columns.

Changing a queue item’s priority

Administrators can change the priority of an item in the queue.

To change a queue item’s priority:

1. Login to Digital Asset Manager.

2. In the tree view in the left pane, select the Transformations node. Go to the transformation queue
by selecting the Transformations node. The transformation queue appears in the main pane.

3. Find the target item in the queue.

4. Select the item, and right-click with your mouse.

5. Choose View from the context menu.
The transformation details of this item are displayed.

6. Change the numeric value in the Priority box. The highest priority is 10. The higher the numeric
value, the higher the priority level. When the priority level is changed, the queue position of
the object will change automatically.
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7. Click OK. The page returns to the list the transformation queue. Confirm that the queue position
has changed. The color code of the priority item should change to a higher priority. See Viewing
transformation requests in the queue, page 34 for queue item priority level color codes.

Viewing details of a queue item

When a pending item is in the queue, the following transformation details are available depending on
which fields are configured:
• Description gives the name of the transformation being performed, such as Rotate.

• Parameters lists any user-defined parameters for this transformation, if applicable. For a
transformation such as Rotate, for example, the angle of rotation would be a parameter.

• From gives the name of the user who requested the transformation.

• Received is the date and time the transformation was requested.

• Source is the source (or input) file name being transformed.

• Priority is given to a queue item with the highest numeric value.

• Target is the target (or output) file name for the transformation. If the request is to create a
rendition, the Target field will show "None".

• Queue position gives the specific order number of this item in the queue.

To view details of a queue item:

1. Login to Digital Asset Manager.

2. In the tree view in the left pane, select the Transformations node. Go to the transformation queue
by selecting the Transformations node. The transformation queue appears in the main pane.

3. Find the target item in the queue.

4. Select the item, and right-click with your mouse.

5. Choose View from the context menu.
The transformation details of this item are displayed.

Deleting a pending queue item

Administrators can delete any items in the queue. Users can only delete their own queue items. The
deletion is not immediate for users. Items are marked, then polled and then deleted.

To delete a pending queue item:

1. Go to the transformation queue by selecting the Transformations node.
The transformation queue appears in the main pane.

2. Find the item(s) to delete from the queue.
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To find items quickly, you can configure the display as follows:
• Sort alphabetically by document name by clicking the header on the Document column.

• Sort the requests alphabetically by user name by clicking the header on the Sent by column.

• Toggle between all users’ transformation requests or your own transformations using the
Show list box.

3. Select the item(s), and right-click with your mouse.

Note: You can select a range of items using the Shift key, or select multiple items using the
Ctrl key.

4. Choose Delete from the context menu.
A delete confirmation page appears for each file you selected.

5. Select OK to confirm a deletion, or click Cancel to abort a deletion request.
If the queue item is pending, it will be deleted and removed from the transformation queue. If the
queue item is being processed, an error will show saying "Transformation request is being processed,
can’t delete."

Configuring additional queue management fields

Users can customize the queue management fields by adding additional columns.

To configure additional queue management fields:

1. Login to Digital Asset Manager.

2. Go to the Transformation node.
The right pane shows the default column fields.

3. Click on the Column Preferences button.
The screen will refresh and show the Preferences: Display Settings on the left and the default
column setting on the right.

4. Select an additional item from the left list "Select attributes to display". Click the button to add to
the right list "Selected attributes to display as column". The right list shows the new attribute
added. Click OK.
The list view appears.

5. Verify that the list view has the additional columns.

Removing a queue management field

Users can customize the column fields by removing select columns.

To remove a queue management field:

1. Login to Digital Asset Manager.

2. Go to the Transformation node.
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The right pane shows the default column fields.

3. Click Column Preferences.
The screen will refresh and show the Preferences: Display Settings on the left and the default
column setting on the right.

4. Select an item from the right list "Selected attributes to display as column".
Click button to move it to the left list "Select attributes to display". The right list shows the
new attribute removed.
Click OK.
The list view appears.
Verify that the list view has one less column.

Configuring the queue pre-processor
mechanism to manage queue item sign-off
This procedure mainly applies if you have different CTS products polling the same repository but
installed on separate hosts.

The queue pre-processor mechanism analyzes queue items and marks those that can be executed by
the CTS instance, preventing items from being prematurely expired by a CTS instance that cannot
handle them. This will also help the regular queue processor thread not to perform the capability
checking again during the execution. The pre-processor tasks run with their own sessions.

This functionality is controlled by two elements in the CTSServerService config file:

• allowQueuePreProcessing

This element is used to pre-process queue items when CTS starts up. If the value is set to "YES",
the pre-processor thread will be created. By default, the value is set to "NO", and there is no
pre-processing mechanism.

• markerInterval

This element sets the wait period between consecutive queue pre-processing jobs.

The expiration period and marking interval should be tuned based on each system configuration. On
a system with similar CTS products polling the same queue, the marker mechanism is not required
and thus the default setting is appropriate. However, if there are different CTS products running
against a repository, one CTS instance might expire items (because it cannot handle them) when the
instance that could handle them is busy. In this case, the pre-processing mechanism should be turned
on for those instances that could process the items.

Controlling how quickly programs time out
When a Content Transformation Services product is processing a request, it calls external programs,
such as Microsoft Word, as part of the process. There may be occasions when one of these programs
fails, or simply runs longer than you want it to run. To control the resources consumed by an external
program, Content Transformation Services products include an application timeout parameter. The
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value assigned to the parameter determines how long the product waits for an external program
to complete its process before moving on to the next request. The timer starts when the Content
Transformation Services product calls the external program.

For example if Document Transformation Services calls Microsoft Word to print a PDF version of
a document and that program does not complete within 30 seconds, Document Transformation
Services abandons the request and checks the queue for the next request. When a rendition operation
fails, Document Transformation Services sends a message reporting the failure to the Document
Transformation Services log file and also to the requester’s Inbox.

The value for the application timeout parameter is controlled by the following related tags in the
plug-in configuration file:
<APPLICATION_WAIT_INTERVAL>10</APPLICATION_WAIT_INTERVAL>
<APPLICATION_MONITOR>true</APPLICATION_MONITOR>

For example, if you want to configure this value to 30 seconds for any Word transformation, modify
the tags of the word.xml file (available under the folder %CTS_HOME%\CTS\config\word\) as
follows:
<APPLICATION_WAIT_INTERVAL>30</APPLICATION_WAIT_INTERVAL>
APPLICATION_MONITOR>true</APPLICATION_MONITOR>

The wait interval represents the amount of time (in seconds) between retries. The max_retries value
multiplied by the wait_interval value gives the timeout parameter value.
<MAX_RETRIES>60</MAX_RETRIES>
<WAIT_INTERVAL>5</WAIT_INTERVAL>

For example, if you want to configure this value to 30 seconds, modify the values as follows:
<MAX_RETRIES>6</MAX_RETRIES>
<WAIT_INTERVAL>5</WAIT_INTERVAL>

Note: This task can also be performed through the Content Transformation Services Administration
component in Documentum Administrator. See Chapter 2, Administering and Configuring Content
Transformation Services Products Through Documentum Administrator.

Aligning DTS and ADTS with the Adlib timeout

There is a timeout setting in DTS and ADTS. If a rendition takes longer than that it will fail. This
is set in pdf.xml and the default is 5 seconds.

However Adlib, in the background, keeps on rendering the request until it is done and will be
blocked for any further requests from DTS or ADTS. Align the timeout configuration in the CTS
plugins with the one in the 3rd party using the following procedure:

1. Calculate the plugin timeout as follows. From either
%CTS%\config\advancedpdf\advancedpdf.xml (ADTS) or
%CTS%\config\pdf\pdf.xml (DTS) get the values from the following nodes:
<MAX_RETRIES>60</MAX_RETRIES>
<WAIT_INTERVAL>5</WAIT_INTERVAL>

The product will be the plugin timeout in seconds.

2. Next stop the Adlib FMR, Adlib Process Manager, and Exponent Connector.
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3. Go to % CTS%\Adlib\Express and double-click adexps.exe.

4. Go to Tools > Application Settings. You can control the timeout from there.

5. Make sure "Enable FMR" is checked and that the timeout values there match in seconds what was
retrieved from the plug-in.

6. Restart the services
Once restarted you can check timeout from HKEY_LOCAL_MACHINE\SOFTWARE\Adlib\Adlib
FMR\Adlib Express\Default

Caching CTS capabilities on startup
An option is available to cache a CTS instance’s execution capabilities. CTS can cache execution
capability information of all the atomic profiles in the repositories in which a CTS instance is
configured against. This caching can be done either during the CTS startup which can be configured
in the CTSProfileService.xml, or during the first load balancer call for getting the capabilities. Please
refer to the following tags added to the service configuration file. The default value is set to true,
which means CTS will cache this capability information during startup:
<ProfileConfig ProfileConfigName="cacheCapabilityOnStartup" ProfileConfigValue="true"/>

The logging information related to this is logged to a separate log file configured in the
log4j.properties CAPABILITYAppender (refer to the section Setting logging appenders, page 40).

While performing profiles across instances, if CTS identifies a remote instance, capable of
executing any of the inner atomic profiles of a nested profile, CTS caches this information up to
the profileRefreshInterval attribute value configured in the following tag. This value represents
numbers of minutes.
<ProfileConfig ProfileConfigName="profileRefreshInterval" ProfileConfigValue="5"/>

CTS requires its own log4j.properties files
CTS shares the same log4j.properties with other applications (such as the CTS Agent or the Flip
Factory Notifier plugin). As a result the log files do not get renamed and continue to grow in size
indefinitely. Therefore, CTS products require their own log4j.properties files in order to have their
log files rollover as configured. Also, CTS Agent or FlipFactory Notifier should specify their own
log4j.properties. The content of the properties file should also be specific to the application, meaning
that the files should not contain duplicated appenders. If they do, the log files should be configured
with different paths.

The log4.properties location can be specified as a JVM parameter.

• For CTS, you need to edit an existing registry entry: HKEY_LOCAL_
MACHINE\SYSTEM\CurrentControlSet\Services\DocumentumCTS\Parameters\AppParameters
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In that registry value, locate the Dlog4j.configuration jvm option Dlog4j.configuration and change
the path to some CTS specific folder.

• For FlipFactory Notifier, you need to add a registry entry at HKEY_LOCAL_
MACHINE\SYSTEM\CurrentControlSet\Services\Flip Engine\Parameters. The
name of the registry entry would be ‘JVM Option Number X’, where X is the next
available index in the list and the value would be ‘-Dlog4j.configuration=file:C:\Program
Files\Telestream\FlipFactory\Plugins\com\documentum\ffplugin\notify\log4j.properties’.
(The path is just an example.)

• For CTS Agent, rather than using a JVM parameter, it is easier to drop the log4j.properties at this
location: %CTS%\AdminAgent\webapps\CTSAgent\WEB-INF\classes

For all above locations, you can copy the original properties (for example,
C:\Documentum\config\log4j.properties) and make sure the appender entries reflect only the
application for which the log4j.properties is meant. For example, the FlipFactory Notifier needs only
the appender for com.documentum.ffplugin.*. Also, all paths for log files should be configured
to application specific path.

Setting logging appenders
Separate Logging appenders are added to the log4j.properties for logging the polling and capability
caching information. Please refer to the following entries in the log4j.properties file:
log4j.category.POLLINGAppender=INFO, POLLINGAppender

log4j.appender.POLLINGAppender=org.apache.log4j.DailyRollingFileAppender

log4j.appender.POLLINGAppender.File=R $C(CTS, PARENT_DIR)\\logs\\Polling_log.txt

log4j.appender.POLLINGAppender.Append=true

log4j.appender.POLLINGAppender.layout=org.apache.log4j.PatternLayout

log4j.appender.POLLINGAppender.layout.ConversionPattern=%d{HH\:mm\:ss,SSS} %10r
%5p [%10t] %-20c - %5x %m%n

log4j.appender.POLLINGAppender.DatePattern='.'yyyy-ww-dd

log4j.category.CAPABILITYAppender=INFO, CAPABILITYAppender

log4j.appender.CAPABILITYAppender=org.apache.log4j.DailyRollingFileAppender

log4j.appender.CAPABILITYAppender.File= $C(CTS, PARENT_DIR)\\logs\\Capability_log.txt

log4j.appender.CAPABILITYAppender.Append=true

log4j.appender.CAPABILITYAppender.layout=org.apache.log4j.PatternLayout

log4j.appender.CAPABILITYAppender.layout.ConversionPattern=%d{HH\:mm\:ss,SSS} %10r
%5p [%10t] %-20c - %5x %m%n

log4j.appender.CAPABILITYAppender.DatePattern='.'yyyy-ww-dd
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The log files Polling_log.txt and Capability_log.txt corresponding to these appenders will have the
logs related to polling and capability caching information respectively. This information will not be
logged to the main CTS_log.txt file. The log level can be set to DEBUG for getting more information.

Enabling performance and throughput logging
The ability to create a separate performance log file is available. The following entry in the
log4j.properties file will enable this functionality:
com.documentum.performancelogging.enabled=false
com.documentum.performancelogging.file=<$CTS_HOME>\\logs\\Performance_log.txt

The default value is set to ’false’. Setting this value to ’true’ will create a Performance_log.txt under
$CTS_HOME logs folder.

You may also edit the value of the following entry to define the interval of rolling up performance
log into storage repository:
com.documentum.performancelogging.rollupInterval=24H

The value format is an integer number+H(case insensitive). For example, for an interval of 12 hours,
the value is 12H. If omitted, the value will be the default of 24H. When the interval value has been
reached, the performance log will be parsed and a performance and throughput report xml will
be generated. Then, a zip file, which contains the report xml and the related style sheets, will be
uploaded to the storage repository as defined in the SessionService.xml.

ICMS web service provides a Metric Service to parse the zip files from the storage repository and
create metric report on the performance and throughput data.

Processing requests for local content
CTS includes a configuration element called "processLocalContentOnly” which is useful in
distributed environments to instruct CTS to process requests for content residing in local (near) file
stores and not pick up requests for content in distant files stores.

The configuration is in the file %CTS%\config\CTSServerService.xml. Under each
<QueueProcessorContext> node there is a line:
<CTSServer AttributeName="processLocalContentOnly" AttributeValue=""/>

Valid values are YES or NO. The default is NO.

Configuring CTS for Branch Office Caching
Services
If required, use the Branch Office Caching Services documentation to install BOCS and configure it for
a global registry. The following section outlines the procedures required to configure CTS for BOCS.
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The following are limitations of BOCS with CTS:

• Inbound operations (saving renditions and checking-in) are not supported.

• Saving renditions is not supported due to the DFC limitation (IDfImportOperation does not
support adding renditions).

• Checking-in (version up) is not supported.

• XML documents are exported through DFC. DFC does not allow to transfer xml contents through
BOCS/ACS even though the BOCS/ACS options are specified.

To configure CTS for Branch Office Caching Services:

1. For all CTS configured repositories, update the CTSServerService.xml file located at
%CTS%\config\.
The file may be updated at the master configuration level:
<CTSServerConfig>
...
<BocsConfig networkLocationId="" allowBocsTransfer="true" preferAcsTransfer="true"
allowSurrogateTransfer="true"/>
...
</CTSServerConfig>

You may also overwrite the master settings, using repository specific preferences, through the
queue processor configuration:
<QueueProcessorContext DocbaseName="my_repository">
...
<CTSServer AttributeName="networkLocationId" AttributeValue=""/>
<CTSServer AttributeName="allowBocsTransfer" AttributeValue=""/>
<CTSServer AttributeName="preferAcsTransfer" AttributeValue=""/>
<CTSServer AttributeName="allowSurrogateTransfer" AttributeValue=""/>
...
</QueueProcessorContext>

These options are based on IDfAcsTransferPreferences:
• networkLocationId: The prefered network location identifier if multiple network locations
can be applied to the machine. The network location identifiers need to be configured in the
global registry repository. If this is not set, the first available network location identifier
will be used.

• allowBocsTransfer: Specifies whether BOCS content transfer is allowed (default: true)

• preferAcsTransfer: Sets the accelerated content transfer preference (default: true)

• allowSurrogateTransfer: Specifies whether surrogate transfer is allowed (default: true)

2. Update the canExecuteProfile and QueueProcessor elements.
canExecuteProfile checks if the contents for a transformation are available and saves it for the
queue processor. The contents for a transformation are NOT available if all of the following
conditions meet:
• Any of the source contents are parked.

• allowBocsTransfer is NOT enabled or the BOCS server is NOT reachable from the CTS
machine (configurable through the network location ID). If the BOCS server is not reachable,
DFC does not return the URL for the content.
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The queue processor checks the content availability flag before signing off a queue item. If the
content is not available, it does not sign off the queue item and it will not be expired either.

3. Update the export operations.
If allowBocsTransfer or preferAcsTransfer is set and the ACS transfer is configured for the
repository, all the export operations will specify the ACS preference options and try to get the
transfer URLs for contents.
If the transfer URLs are returned, the contents will be downloaded through the URL protocols.

Configuring queue management for BOCS
installations
In a scenario where a Documentum installation has a remote location with a BOCS server and a
transformation server, the following configuration will improve queue management.

For example, New York is the main site and Berlin is the remote site in the installation. Users in
New York import a large number of objects in a day (for example, 3,000) which are queued for
transformation, all with the same priority. Later, Berlin users import only 10 objects. While the New
York CTS product server is processing items 1-3000, the expectation is that the items from Berlin
would be picked up by the Berlin CTS product server if they are still parked there. However, the
actual behavior is that the objects must wait until the rest of the queue is cleared, greatly reducing the
advantage of having an CTS product server co-located with BOCS. Improving queue management or
providing the ability to change the query used would help this situation.

To allow a CTS instance to poll only for queue items of content parked at a specific
BOCS location:

1. Open the CTSServerService.xml configuration file at %CTS%\config\.

2. The xpath of the configuration element is //CTSCustomConfig/CTSServerConfig/
BocsConfig@processOnlyParked

3. Navigate to:
<BocsConfig allowBocsTransfer="true" allowSurrogateTransfer="true"
networkLocationId="My_Network_id" preferAcsTransfer="true"
processOnlyParked="false"/>

When the attribute, processOnlyParked, is set to "true", the CTS instance processes only parked
content available at the configured network location ("My_Network_id" in the example above).
This configuration applies to all repositories.

4. Navigate to the node <QueueProcessorContext> for the repository.

5. All configuration elements from <BocsConfig> can be added to the <QueueProcessorContext>
nodes, if a repository requires other (than default) settings. For example:
<QueueProcessorContext DocbaseName="repository_009">
...
<CTSServer AttributeName="allowBocsTransfer" AttributeValue="true"/>
<CTSServer AttributeName="allowSurrogateTransfer" AttributeValue="false"/>
<CTSServer AttributeName="networkLocationId" AttributeValue="second_network"/>
<CTSServer AttributeName="preferAcsTransfer" AttributeValue="true"/>
<CTSServer AttributeName="processOnlyParked" AttributeValue="true"/>
</QueueProcessorContext>
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6. You must also add a child node as follows:
<CTSServer AttributeName="parkingServerName" AttributeValue="BOCS_ABC"/>

where BOCS_ABC is the name of the BOCS server that you want CTS to process content from.
The above works in conjunction with the "processOnlyParked" configuration element meaning
CTS needs both the BOCS Server Name configured as above and processOnlyParked set to ’true’.

Load balancing servers
The standard installation for Content Transformation Services products consists of one repository
with one server. Additional servers can be added to an active repository to enhance its performance.
Load balancing can optimize performance by spreading transformation requests between multiple
servers.

Load balancing can be achieved by adjusting settings in the CTSserverservice.xml file, in the
%CTS%\config folder. By default, CTS products are equipped with a standard load balancing
strategy.

The ideal load balancing strategy depends upon your environment and the specific servers in use.
Contact your Documentum consulting representative for load balancing guidance.

Configuring CTS Load Balancer

The preferences.xml file (default location is C:\Documentum\cts_ws\config) allows
configuration for various aspects of load balancer functionality. The following details what each line
of the configuration file does.

This line is used to configure how Content Transformation Services should handle the request:
<LoadBalancer type="remote" URL=" http://host:port/services/transformation/LoadBalancer/"
sendMode="remote"/>

• type="local” - load balancer runs within the same JVM as the API client

• type="remote” && sendMonde="local” - call is made to the remote load balancer (specified in
URL="http://..." ) to retrieve the CTS instance URL and the SBO sends the request

• type="remote” && sendMonde="remote” - call is made to the remote load balancer to select
the instance and send the request

These two lines control failover retries for the case where a request is sent to CTS but comes back
with an error:
<ServerProperty Description="Allow a number of retries if a request sent to CTS
fails" Key="FailoverRetries" Value="1"/>
<ServerProperty Description="Wait between failover retries (seconds)"
Key="FailoverWait" Value="1”/>

Specify how frequent the load balancer should refresh its "CTS occupancy level” cache:
<ServerProperty Key="CTSOccupancyPollingInterval" Description="Specify occupancy
polling interval in seconds" Value="7"/>
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Specify the number of repository connection retries (in case <Repositories> node is not configured):
<ServerProperty Key="ConnectionRetries" Description="Specify connection retries
(in case Repositories section is not configured )" Value="10”/>

Control failover for the scenario where no CTS instances are found that are available to execute
a request (that is, an instance is busy or starting up, meaning there is chance in the near future
it could become available):
<ServerProperty Key="AvailabilityRetries" Description="Number of retries when
CTS instances are not available" Value="0"/>
<ServerProperty Key="AvailabilityWait" Description="Number of seconds to wait
for rechecking availability" Value="0"/>

Use this configuration element to specify a list of semicolon separated CTS instances (host name as it
appears in cts_instance_info). It can be used to have one or more instances process only asynchronous
requests or scale up the load balancer by assigning a specific set of CTS instances to one load balancer
and a different set of CTS instances to another load balancer(CTS instances from the same repository):
<ServerProperty Key="CTS_SkipList" Description="list of cts instances (semicolon
separated) to skip (scalability)" Value="CTS1;CTS3"/>

The ”InstanceSelector” property specifies the selection algorithm used by the load balancer. The new
value points to the occupancy based implementation:
<ServerProperty Key="InstanceSelector" Description="Specify an implementation class
for instance selection "
Value="com.emc.documentum.cts.lb.workers.OccupancyBasedSelector"/>

Note: The InstanceSelector value is used internally and should not be changed.

Configuring CTS Server to run in SSL Mode
CTS Server and CTSWeb Services can be configured to run in SSL mode (that is, https instead of http).

This is enabled at the application server level, where each application server has their own procedure
to make it handle https. However, CTS must be updated to accept the new SSL port.

For any real time requests, the CTS Webservice server communicates to the CTS Server through
http. CTS server bundles the Jetty application server with it. To configure this communication in
SSL (https) mode, the following procedures have been provided.

To configure CTS WebServer to run in SSL mode, consult publicly available reference
material, for example, http://i-proving.ca/space/Technologies/JBoss/Configuring+JBoss+SSL or
http://it.amid.com/2009/01/27/ssl-from-java-client/.

To configure CTS Server to run in SSL mode:

1. Jetty’s status can be verified as follows:

a. Start the CTS server.

b. Run the following query against the repository to get the Jetty running url:
Select websrv_url, hostname from cts_instance_info

c. Try the attribute value of websrv_url from a browser to see if it is running.

2. Configure Jetty to run in SSL mode. The following site may be helpful: http://docs.codehaus.
org/display/JETTY/How+to+configure+SSL
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a. The Jetty config file can be found on the CTS server under \CTS\Jetty\.

b. To verify the new SSL url, run the following url from the CTS server browser:
http://<localhost>:<ssl_port>/cts/

c. If the url is successful, update the cts_instance_info object in the repository to set the new
url to websrv_url attribute by running the following query:
Update cts_instance_info object set websrv_url=<new_ssl_url> where
hostname=<ctsserver_hostname_here>

d. Restart the CTS server.

e. Restart CTS Webserver service.

Using a profile description bigger than 192
bytes
The profile description length for new or edited profiles is up to 192 bytes. Please note that Russian
characters can be either 2 or 3 bytes. To use a description that exceeds 192 characters, perform the
following procedure:

1. Run the following DQL queries against the repository:
EXECUTE ALLOW_BASE_TYPE_CHANGES WITH ALLOW_CHANGE_FLAG=1

2. Alter type dm_sysobject modify subject char(300):
EXECUTE ALLOW_BASE_TYPE_CHANGES WITH ALLOW_CHANGE_FLAG=0

3. For Second successive run we need to change it to (301):
EXECUTE ALLOW_BASE_TYPE_CHANGES WITH ALLOW_CHANGE_FLAG=1

4. Alter type dm_sysobject modify subject char(301). ( The reason for providing the size as 301 is,
the size specified for the subject attribute should be greater than the previous value, else server
throws an error)
EXECUTE ALLOW_BASE_TYPE_CHANGES WITH ALLOW_CHANGE_FLAG=0

Caution: Use caution when running DQLs against the repository as any input errors may
cause damage.

Automating thumbnail/proxy creation for
custom formats derived from an existing
rich_media_enabled supported CTS dm_format
To automate thumbnail/proxy creation for custom formats:

1. Set the richmedia_enabled flag to "1” for the custom format by running the following DQL:
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update dm_format object set richmedia_enabled = 1 where name=’custom_format_name’

2. If the dm_format name and dos_extension are different for a custom format, the
FormatMapperService.xml file (under \CTS\config folder) should be updated as follows:

<FormatMapper CTSFormat="dos_extension" DocumentumFormat="dm_format_name"/>

3. Check out the following system profiles from the repository:

• register

• thumbnail (if the parent format is part of this profile)

• autoGenProxy (if the parent format is part of this profile)

• pdf_processing, thumbnail_pdfstoryboard , autoGenProxy_pdfstoryboard, and
storyboard_pdfstoryboard (if the custom format is a flavor of pdf format)

• powerpoint_registration (if the custom format is a flavor of powerpoint format)

4. Add the custom format entry to the appropriate profiles.

5. Check in the profiles.

6. Restart CTS Service.

Performing bulk transformation requests for
documents
Sometime it is useful to submit transformation requests in bulk. Such scenarios can occur when
you have legacy documents that were ingested prior to deployment of a CTS product. Also, you
may want to resubmit a number of documents for a specific job because CTS failed to process them
initially and the job requests were removed.

CTS provides a tool that can request transformation requests for a group of documents. This tool is
deployed under %CTS%\docbases\<your_repository>\CTSServerScript\.

Use \config\script.xml to configure the process, then use \bin\script.bat to run it. By default, the
tool will use the script.xml from the location mentioned above but you can also modify the script
batch file to use a different configuration file.

Configuration schema definition

The DTD for the tool configuration is found at \config\MediaServicesScript.dtd

Below is a definition of all configuration elements.
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MediaServicesScript

Purpose

Top level element for job submission.

Attributes
None

Children
<Profile> (one or more)

<LogFile>

Parents
None

Usage Notes
N/A
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Profile

Profile

Purpose

The main node to define a set of transformation for a CTS profile

Attributes

path

The repository path of the transformation profile.

Example: /System/Media Server/System Profiles/legacy_to_pdf

isRegisterQueue

Set this attribute to ‘true’ if the jobs should be creating of dm_register_asset queue item events

Children
<TransformRequest> zero or one

<LoginContext>

<MaxDocs>

<Format> (one or more) OR <All_Richmedia_Enabled> OR <DQL_Query>

<Priority>

Parents
<MediaServicesScript>

Usage Notes
Use this node to specify the transformation needed for a set of documents. This node can be used
multiple times for the same or different transformation profile.
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LoginContext

LoginContext

Purpose

Specify repository name and credentials.

Attributes

username

A repository user name with sufficient permissions

passwordfile

The path to a file with the encrypted password for the selected user.

docBase

The repository name.

domain (optional)

An optional domain name, when the repository is in "domain required” mode.

aekFilePath

The path to the AEK file

Children
None

Parents
<Profile>

Usage Notes
N/A
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TransformRequest

Purpose

This can be used to enable the creation of new objects instead of renditions.

Attributes

isRender (true | false)

Set this to false if you need new objects.

repositoryFolder

Is valid only when isRender="false". If a value is present, the new object will be stored under this
folder. If the value is "_same_as_parent_", the new object will be created under the corresponding
parent object folder. If it has no value, the new object will be stored under the user’s home cabinet.

objectType

Is valid only when isRender="false". If object type is not present, the new object will be stored
as dm_document. objectType can be dm_document or any of its subtypes. If the value is
"_same_as_parent_", the new object will be stored using the source object type.

Children
None

Parents
<Profile>

Usage Notes
N/A
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MaxDocs

MaxDocs

Purpose

This node helps you control the number of documents that will be submitted for the selected
transformation.

Attributes
None

Children
<All> OR <NumDoc>

Parents
<Profile>

Usage Notes
Use the child node <All> (empty) if we want all documents that match the criteria to be affected.

Use <NumDoc> if you want to limit the number of object. Example: <NumDoc>10</NumDoc>

When you have a large number of legacy documents, it is a good idea to limit the number of jobs
that will be created and then repeat the procedure. Also, you should allow CTS to process the first
bulk before resubmitting a new chunk (i.e. by monitoring the queue). This will help avoid work
duplication.

52 EMC Documentum Content Transformation Services Transformation Suite Version 6.7 Administration Guide



Format

Format

Purpose

This node helps you select a set of documents based on their content type (dm_format).

Attributes

source

The Documentum format of assets to be processed. All documents with this format may be
reprocessed.

target

The target format for the selected transformation.

overwrite (true | false)

If this attribute is false and the selected documents already have a rendition of the specified target
format, then no job will be submitted for such objects.

Children
<Parameters> (zero or more)

Parents
<Profile>

Usage Notes
Use this node when you want to select ALL documents of a specific format. If you want to be more
specific about the set of documents to be processed, use this node within <DQL_Query> instead.
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All_Richmedia_Enabled

All_Richmedia_Enabled

Purpose

Using this node you select all documents of all documentum formats that are rich media enabled.
This is the least restrictive criteria. Use with caution.

Attributes

overwrite (true | false)

If this attribute is false and selected documents already have a rendition of the specified target format,
then no job will be submitted for such objects.

Children
<TargetFormat>

Parents
<Profile>

Usage Notes
Use this node when you want to select ALL documents of ALL rich media enabled formats. If you
want to further restrict the set of documents to be processed, use <Format> or <DQL_Query> instead.
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TargetFormat

TargetFormat

Purpose

Using this node you specify the target format when <All_Richmedia_Enabled> is used.

Attributes

name

The target format for the selected transformation.

Children
<Parameters> (zero or more)

Parents
<All_Richmedia_Enabled >

Usage Notes
N/A
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Parameters

Parameters

Purpose

You can use nodes like this to specify parameters for the selected transformation (i.e. profile).

Attributes

name

parameter name

value

parameter value

Children
None

Parents
<Profile>

Usage Notes
Examples:
<Parameters name="doc_token_direction" value="horizontal" />
<Parameters name="doc_token_targetFormat" value="jpeg_lres" />
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DQL_Query

DQL_Query

Purpose

Using this node to specify a DQL that would select specific documents .

Attributes

query

The DQL.

Children
<Format> OR <SameAsInputFormat>

Parents
<Profile >

Usage Notes
The DQL used should return two columns: r_object_id and a_content_type.

Use child node <SameAsInputFormat> instead of <Format> when the target format should be the
same as the format of the document being submitted for a transformation.

Example A:
<DQL_Query query="select distinct a.r_object_id, a.a_content_type from dm_document a,
dm_format b where a.a_content_type = b.name and b.richmedia_enabled = 1 and not
exists (select 1 from dmr_content_r c where a.r_object_id = c.parent_id and
c.i_full_format = 'jpeg_th') " >

<Parameters name="doc_token_targetFormat" value="jpeg_lres" />

Example B:
<DQL_Query query="select r_object_id from dm_document where a_content_type='jpeg'
AND owner_name='signs'">
<Format source="jpeg" target="jpeg_th" overwrite="true" />
</DQL_Query>
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Priority

Priority

Purpose

Specify the priority of the jobs.

Attributes

value

a numeric value (1-9)

Children
None

Parents
<Profile>

Usage Notes
None
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LogFile

LogFile

Purpose

Specify the path for the log.

Attributes
None

Children
None

Parents
<MediaServicesScript>

Usage Notes
None
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Chapter 4
Configuration Tasks for Document
Transformation Services and Advanced
Document Transformation Services

The following sections detail configuration tasks that are specific to Document Transformation
Services and/or Advanced Document Transformation Services:
• Creating PDF renditions and enabling thumbnail and storyboard renditions on import (DTS &
ADTS), page 61

• Customizing printing and rendition output (DTS), page 65

• Configuring change tracking (DTS), page 68

• Transferring document attributes (DTS), page 68

• Enabling profile parameter to render the actual drawing page size of Visio files (DTS & ADTS),
page 71

• Enabling PS/PDF for any format using defaultApp Plug-in (DTS & ADTS), page 71

• Retaining A4 paper size for MS Excel files (ADTS), page 74

Creating PDF renditions and enabling
thumbnail and storyboard renditions on import
(DTS & ADTS)
To automatically create PDF renditions when importing content, you must first rich-media enable the
particular format, and then edit the register.xml file.

Advanced Document Transformation Services can also create thumbnail and storyboard renditions
when importing content.

After rich-media enabling the formats, you need to modify the register.xml file to activate the
PDF rendition on import.
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Rich-media enabling formats

This procedure is essential to proper processing of imported content. If formats are not rich-media
enabled, the Content Server will not pass them to the Advanced Document Transformation Server
queue.

To rich-media enable formats:

1. Run the following DQL statement:
update dm_format object set richmedia_enabled = 1 where name
in ('<format name>')

For example, to create thumbnails and storyboards for Microsoft Excel and Word formats, run the
following DQL statement:
update dm_format object set richmedia_enabled = 1 where
name in ('excel8book','msw8')

Table 5, page 62 lists some examples of the format mapping used in Documentum systems. Use
these format names in DQL.

Table 5. Documentum format mappings for Document Transformation Services and Advanced Document
Transformation Services

Description Documentum name (includes
Office 2003)

Documentum name (Office
2007 only)

CAD drawings (DWF, DWG) acad

Corel WordPerfect (WPD) wp8, wp10+

HTML html

Microsoft Excel (XLS) excel8book excel12book

Microsoft Excel (XLT) excel8template excel12template

Microsoft PowerPoint (POT) ppt8_template ppt12template

Microsoft PowerPoint (PPT) ppt8 ppt12

Microsoft Visio (VSD) vsd, vsd1, vsd2, vsd3, vsd4

Microsoft Word (DOC) msw8 msw12

Microsoft Word (DOT) msw8template msw12template

PDF pdf

Creating a PDF rendition on import

After rich-media enabling the formats, you need to modify the register.xml file to activate the
PDF rendition on import.

To activate the PDF rendition on import:

1. In the repository, browse to System/Media Server/System Profiles and check out register.xml.
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2. Open register.xml in an XML or text editor.

3. Change the following tag:
<Format source="<sample>" target="<sample>"/>

to
<Format source="<Add source format here>" target="<Add target format here>"/>

For example, to enable PDF renditions for Microsoft Word documents, your tag would look like
the following:
<Format source="msw8" target="msw8"/>

Note: Source and target formats are the same in the register profile. This is because processing
does not start from this profile; the source is passed to the next profile.

4. Add the following tags to the <ProfileSequence> section, if it is not already included:
<InnerProfile path="/System/Media Server/System Profiles/
document_to_pdf" waitOnCompletion="true" useTargetFormat="true">
<InnerTokenMapping LocalProfileToken="pdf" InnerProfileToken=
"doc_token_targetFormat" Literal="true"/>
<InnerTokenMapping LocalProfileToken="PDFVersion15"
InnerProfileToken="doc_token_pdfVersion" Literal="true"/>
<InnerTokenMapping LocalProfileToken="Automatic" InnerProfileToken
="doc_token_usePrinterMetrics" Literal="true"/>
<InnerTokenMapping LocalProfileToken="600" InnerProfileToken=
"doc_token_resolution" Literal="true"/>
<InnerTokenMapping LocalProfileToken="Yes" InnerProfileToken=
"doc_token_optimize" Literal="true"/>
<InnerTokenMapping LocalProfileToken="Yes" InnerProfileToken=
"doc_token_enableBookMarks" Literal="true"/>
<InnerTokenMapping LocalProfileToken="DocumentContent"
InnerProfileToken="doc_token_printType" Literal="true"/>
<InnerTokenMapping LocalProfileToken="false" InnerProfileToken
="overwrite_rendition" Literal="true"/>
<InnerTokenMapping LocalProfileToken="legacy" InnerProfileToken=
"transformation_type" Literal="true"/>
<!security settings>
<InnerTokenMapping LocalProfileToken="No" InnerProfileToken=
"doc_token_enableSecurity" Literal="true"/>
<InnerTokenMapping LocalProfileToken="40bit" InnerProfileToken=
"doc_token_encryptionMode" Literal="true"/>
<InnerTokenMapping LocalProfileToken="Disabled" InnerProfileToken=
"doc_token_changesAllowed" Literal="true"/>
<InnerTokenMapping LocalProfileToken="Disabled" InnerProfileToken=
"doc_token_enableAccess" Literal="true"/>
<InnerTokenMapping LocalProfileToken="Disabled" InnerProfileToken=
"doc_token_docAssembly" Literal="true"/>
<InnerTokenMapping LocalProfileToken="Disabled" InnerProfileToken=
"doc_token_formFieldFilling" Literal="true"/>
<InnerTokenMapping LocalProfileToken="Disabled" InnerProfileToken=
"doc_token_printing" Literal="true"/>
<InnerTokenMapping LocalProfileToken="Disabled" InnerProfileToken=
"doc_token_allowCopy" Literal="true"/>
<InnerTokenMapping LocalProfileToken=" " InnerProfileToken=
"doc_token_secOpass" Literal="true"/>
<InnerTokenMapping LocalProfileToken=" " InnerProfileToken=
"doc_token_secCpass" Literal="true"/>
</InnerProfile>

5. To support the msg format, the following <InnerProfile> tag should be inserted after the above
tag as well as the format tag <Format source="msg" target="msg"/>:
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<InnerProfile path="/System/Media Server/System Profiles/transformMsgToPDF"
waitOnCompletion="false" useTargetFormat="true">

<InnerTokenMapping LocalProfileToken="pdf" InnerProfileToken=
"doc_token_targetFormat" Literal="true"/>

<InnerTokenMapping LocalProfileToken="PDFVersion15" InnerProfileToken=
"doc_token_pdfVersion" Literal="true"/>

<InnerTokenMapping LocalProfileToken="Automatic" InnerProfileToken=
"doc_token_usePrinterMetrics" Literal="true"/>

<InnerTokenMapping LocalProfileToken="600" InnerProfileToken=
"doc_token_resolution" Literal="true"/>

<InnerTokenMapping LocalProfileToken="Yes" InnerProfileToken=
"doc_token_optimize" Literal="true"/>

<InnerTokenMapping LocalProfileToken="Yes" InnerProfileToken=
"doc_token_enableBookMarks" Literal="true"/>

<InnerTokenMapping LocalProfileToken="DocumentContent" InnerProfileToken=
"doc_token_printType" Literal="true"/>

<InnerTokenMapping LocalProfileToken="false" InnerProfileToken=
"overwrite_rendition" Literal="true"/>

<InnerTokenMapping LocalProfileToken="legacy" InnerProfileToken=
"transformation_type" Literal="true"/>
</InnerProfile>

6. Save the file.

7. Check the file into the repository.

8. Restart Content Transformation Services.

Registering formats to enable thumbnails and
storyboards (ADTS only)

After rich-media enabling the formats, you need to modify the register.xml file to activate the
thumbnail and storyboard rendition creation on import.

To register the formats:

1. In the repository, browse to System/Media Server/System Profiles and check out register.xml.

2. Open register.xml in an XML or text editor.

3. Change the following tag:
<Format source="<sample>" target="<sample>"/>

to
<Format source="<Add source format here>" target="<Add target format
here>"/>

For example, to enable thumbnails and storyboards for Microsoft Word documents, your tag
would look like the following:
<Format source="msw8" target="msw8"/>

Note: Source and target formats are the same in the register profile. This is because processing
does not start from this profile; the source is passed to the next profile.

4. Add the following tags to the <ProfileSequence> section:
<!--This extract properties for office formats -->
<InnerProfile path="/System/Media Server/System Profiles/
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document_extract_props" waitOnCompletion="true" useTargetFormat=
"true"> </InnerProfile>
<!--This will generate thumbnail, proxy and storyboards for
all document formats -->
<InnerProfile path="/System/Media Server/System Profiles/
document_registration" waitOnCompletion="true" useTargetFormat="true">
<InnerTokenMapping LocalProfileToken="pdf" InnerProfileToken=
"doc_token_targetFormat" Literal="true"/>
</InnerProfile>
<!--This will generate thumbnail, proxy and storyboards for
pdf formats-->
<InnerProfile path="/System/Media Server/System Profiles/
pdf_processing" waitOnCompletion="true" useTargetFormat="true">
</InnerProfile>

5. Save the file.

6. Check the file back into the repository.

7. Restart Content Transformation Services.

Customizing printing and rendition output
(DTS)
The PostScript printer driver is responsible for generating the PostScript outputs. In the background
mode, the PostScript printer driver uses this PostScript file to generate PostScript renditions.

Various printing and rendition processes can be configured in the legacy profiles. By default, these
processes are disabled. You can modify the profiles to:

• Save the PDF text (PDT) file

• Store PDF metadata

• Configure legacy transformations to replace previous renditions, instead of storing multiple
renditions

These configuration procedures are described in this section.

Saving PDT files

The PDF text (PDT) rendition of a document is the text file used specifically for term-hit highlighting.
By default, PDT files are not saved to the repository. If you want to store the PDT rendition of a
document in the repository, you must modify the legacy_to_pdf profile.

To save PDT renditions in the repository:

1. Log in to the Document Transformation Services configured repository as an administrator user.

2. Navigate to System\Media Server\System Profiles\.

3. Check out the legacy_to_pdf profile.

Note: If this file is not immediately visible, select Show All Objects and Versions from the
Show list box.
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4. Open the legacy_to_pdf file from the checkout folder on the local machine.

5. Uncomment the following section:
<!-- uncomment the below section to enable the storing of pdf text files -->
<!--
<InnerProfile path="/System/Media Server/System Profiles/
pdf_to_pdfText_dts" waitOnCompletion="false" useTargetFormat="true">

<InnerTokenMapping LocalProfileToken="pdftext" InnerProfileToken=
"target_format" Literal="true"/>

<InnerTokenMapping LocalProfileToken="pdf" InnerProfileToken=
"source_format" Literal="true"/>

<InnerTokenMapping LocalProfileToken="True" InnerProfileToken=
"doc_token_storePDTRendition" Literal="true"/>

<InnerTokenMapping LocalProfileToken="1" InnerProfileToken=
"target_page_modifier" Literal="true"/>
<InnerTokenMapping LocalProfileToken="false" InnerProfileToken=
"overwrite_rendition" Literal="true"/>
<InnerTokenMapping LocalProfileToken="legacy" InnerProfileToken=
"transformation_type" Literal="true"/>
</InnerProfile>
-->

6. Save and close the file.

7. Check in the modified profile to the repository.
PDF text renditions of documents are now stored in the repository.

Storing PDF metadata

The storing of PDF metadata is also configured in the legacy_to_pdf profile. By default, PDF
metadata is not stored.

To store PDF metadata in the repository:

1. Log in to the Document Transformation Services configured repository as an administrator user.

2. Navigate to System\Media Server\System Profiles\.

3. Check out the legacy_to_pdf profile.

Note: If this file is not immediately visible, select Show All Objects and Versions from the
Show list box.

4. Open the legacy_to_pdf file from the checkout folder on the local machine.

5. Uncomment the following section:
<!-- uncomment the below section to enable the storing of pdf metadata-->
<!--

<InnerProfile path="/System/Media Server/System Profiles/
embedPDFMetadata_dts" waitOnCompletion="false" useTargetFormat="true">

<InnerTokenMapping LocalProfileToken="pdf" InnerProfileToken=
"target_format" Literal="true"/>

<InnerTokenMapping LocalProfileToken="pdf" InnerProfileToken=
"source_format" Literal="true"/>

<InnerTokenMapping LocalProfileToken="True" InnerProfileToken=
"doc_token_embedMetadata" Literal="true"/>

<InnerTokenMapping LocalProfileToken="embed_metadata"
InnerProfileToken="target_page_modifier" Literal="true"/>

<InnerTokenMapping LocalProfileToken="false" InnerProfileToken=
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"overwrite_rendition" Literal="true"/
<InnerTokenMapping LocalProfileToken="legacy" InnerProfileToken=
"transformation_type" Literal="true"/>
</InnerProfile>
-->

6. Save and close the file.

7. Check in the modified profile to the repository.
PDF metadata of documents is now stored in the repository.

Configuring for rendition replacement

By default, Document Transformation Services allows for multiple PDF and HTML renditions from
the same source file. In other words, each time a user transforms a file, an additional rendition is
created and stored. If you would prefer that subsequent renditions replace previous renditions of a
source document, this can be configured using the following procedure.

To overwrite existing renditions when transforming files:

1. Log in to an applicable application (such as Digital Asset Manager) as an administrator user.

2. Navigate to System\Media Server\System Profiles.

3. Check out the following profiles:
• legacy_to_html

• legacy_to_pdf

Note: If these files are not immediately visible, select Show All Objects and Versions from the
Show list box.

4. Open the legacy_to_html.xml file from the checkout folder on the local machine.

5. Locate the following tag within the <InnerProfile> section:
<InnerTokenMapping LocalProfileToken="false"
InnerProfileToken="overwrite_rendition" Literal="true"/>

and change it to:
<InnerTokenMapping LocalProfileToken="true"
InnerProfileToken="overwrite_rendition" Literal="true"/>

6. Save and close the file.

7. Open the legacy_to_pdf.xml file from the checkout folder on the local machine.

8. Repeat Step 5.

Note: The overwrite_rendition token is available for document_to_pdf_dts, pdf_to_pdfText_dts,
embedPDFMetadata_dts, and document_to_ps <InnerProfile> paths in legacy_to_pdf.xml.

9. Save and close the file.

10. Check in the two files.

11. Start the CTS service.
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Document Transformation Services will now store only one PDF or HTML rendition for each source
file.

To duplicate this behavior when the Reset Renditions option is applied, modify the register.xml
file in the same way.

Configuring change tracking (DTS)
By default, Document Transformation Services does not pass change tracking to output PDFs.
However, change tracking can be enabled by configuring the legacy_to_pdf profile.

To enable change tracking:

1. In the repository, browse to System/Media Server/System Profiles and check out
legacy_to_pdf.xml.

2. Open the file in a text editor.

3. Change this line:
<InnerTokenMapping LocalProfileToken="DocumentContent"
InnerProfileToken="doc_token_printType" Literal="true"/>

to this:
<InnerTokenMapping LocalProfileToken="DocumentWithMarkup"
InnerProfileToken="doc_token_printType" Literal="true"/>

4. Save the file.

5. Check in the file to the repository.

Transferring document attributes (DTS)
A document’s attributes are its descriptive characteristics, such as name, title, author, creation
date, object ID, or subject. You can set the values for some attributes. Other attributes, such as the
document’s creation date, are set by the system.

Document Transformation Services lets you transfer these attributes to a document’s PDF rendition
(but not to a document’s HTML rendition). You can then use the attributes for identification or
tracking purposes after the PDF document is exported from the repository where the source
document resides.

Note: Some attributes, like repository ID, may not be visible when viewed through Document Info
in Adobe Exchange.

You can also transfer attribute information to custom plug-ins, where the plug-in needs to know
certain information about a document (such as type, author, or source type).

For example, you could write a plug-in that looks for certain attributes identifying a document as
a Standard Operating Procedure (SOP). If those attributes are found, the plug-in prints a special
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cover page, or adds or subtracts context-sensitive information before the document is rendered
into PostScript format.

Transferring document attributes to PDF and
embedding metadata

To transfer attributes, you must edit the appropriate command-line files of Document Transformation
Services.

The following command-line files are responsible for transferring the attributes from the source
document to the PDF rendition:
• custom_legacy_calls.xml (used by custom plug-ins)

• embedPDFMetadata_dts.xml (used by the transformation profiles for embedding the
metadata)

You define the attribute mapping for PDF renditions under the <PDF_DOC_INFO> tag of these
command-line files. The syntax is:
value = object_alias.attribute[repeating_spec]

An example would appear as follows:
<PDF_DOC_INFO>
...
...
<MetadataMapper name="DCTMobjectTitle" value="title"
token="doc_metadata_dctmTitle"/>
...
...
</PDF_DOC_INFO>

The attribute token is used internally by the server code, and has to be named with the prefix
doc_metadata_ . For example:
token=" doc_metadata_dctmTitle”

Table 6, page 69 explains the attribute mapping arguments.

Table 6. Attribute mapping arguments

Argument Description

key Key can be an existing attribute or a user-defined
attribute. Examples: author, subject, title,
producer.
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Argument Description

object_alias When omitted or specified as o, the object_alias
indicates that the following attribute is that of a
sysobject or one of its subtypes (the document
being rendered). Other valid object_aliases are:

• d (repository config object)

• s (server config object)

• q (attributes from special runtime-computed
items)

Refer to the Documentum Content Server
Administrator’s Guide for more information about
configuration objects.

attribute In the case of o, s, and d object aliases, attribute
dynamically maps the attribute. In the case
of the q object, the only currently available
attributes are sentby, login_ticket, and username.

value For repeating attributes, value defines the
repeating attribute separator (for example, a
comma or a slash). If no separator is defined, and
the attribute is repeating, Content Server maps
only the first attribute in the series [element 0].

Here are some examples of attribute mapping syntax.

The first example shows an attribute where the object alias (o) is implied:
<MetadataMapper name="Subject" value="subject"
token="doc_metadata_subject"/>

The following example shows an attribute mapped with specified object alias:
<MetadataMapper name="DCTMSourceContentType" value="o.a_content_type"
token="doc_token_sourceContentType"/>

The following example shows a comma-separated list of keywords from sysobject:
<MetadataMapper name="Keywords" value="keywords[,]"
token="doc_metadata_keywords"/>

The following example shows a list of authors, separated by // (two forward slashes):
<MetadataMapper name="Author" value="authors[//]"
token="doc_metadata_author"/>

Viewing the attributes in the PDF rendition

To see the transferred attributes for a PDF rendition, choose Document Properties in Adobe Acrobat.
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Enabling profile parameter to render the actual
drawing page size of Visio files (DTS & ADTS)
Document Transformation Services and Advanced Document Transformation Services can render
the actual drawing page size of a Visio file. This has been implemented in the legacy_to_pdf System
Profile. The default value will be "No"..

The following pre-requisites are needed for this parameter:
• Microsoft Visio 2007

• 2007 Microsoft Office Add-in: Microsoft Save as PDF or XPS available at http://www.microsoft.
com/downloads/details.aspx?FamilyID=4d951911-3e7e-4ae6-b059-a2e79ed87041&displaylang=en

To enable this functionality, do the following:

1. Check out the legacy_to_pdf System Profile from your repository.

2. Open the checked out legacy_to_pdf.xml file in an editor.

3. Modify the following:
<InnerTokenMapping LocalProfileToken="No" InnerProfileToken=
"doc_token_actualPageSize" Literal="true"/>

to
<InnerTokenMapping LocalProfileToken="Yes" InnerProfileToken=
"doc_token_actualPageSize" Literal="true"/>

4. Save and close the file.

5. Check in the profile as a new minor version

Enabling PS/PDF for any format using
defaultApp Plug-in (DTS & ADTS)
To enable PS transformation for ANY source format through DefaultApp Plug-in for DTS or ADTS,
perform the following procedures.

To configure DefaultPostScript Printer Driver:

1. Open the Windows Printers and Faxes window.

2. Right-click the Default PostScript Printer icon and select Properties.

3. Select the Ports tab.

4. In the list of ports, select C:\DISTASST.PS if it exists, and proceed to Step 8.
If the C:\DISTASST.PS port does not exist, proceed to the next step.

5. Click Add Port.

6. Select Local Port from the list and then click New Port.

7. Enter C:\DISTASST.PS for the name and click OK.

8. Click Apply and then Close

EMC Documentum Content Transformation Services Transformation Suite Version 6.7 Administration Guide 71

http://www.microsoft.com/downloads/details.aspx?FamilyID=4d951911-3e7e-4ae6-b059-a2e79ed87041&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=4d951911-3e7e-4ae6-b059-a2e79ed87041&displaylang=en


Configuration Tasks for Document Transformation Services and Advanced Document Transformation Services

To support a source format with file extension ‘xyz’ for PS transformation:

1. Make sure the file format has a default application associated with it. Double-click a sample file
and see if it is opened in its default application on the ADTS/DTS machine.

2. Open the taskmanager and obtain the corresponding process name (for example: xyzProcess.exe).

3. Close the file.

4. Make sure there is a dm_format associated with this format.

5. Stop the CTS Server Service.

6. If the dm_format name and file extension are different, then update the file
\CTS\config\FormatMapperService.xml to have the FormatMapper entry corresponding
to the format as follows and save the file.
<FormatMapper CTSFormat="xyz" DocumentumFormat="dm_format_name_here"/>

If the format extension and dm_format name are the same, go to the next step.

7. Open the file \CTS\config\defaultapp\defaultapp.xml in any xml editor.

a. Add a new Format section under the <SUPPORTED_FORMATS> section. In this example,
xyz is the dos_extension value of dm_format:
<SUPPORTED_FORMATS>
:
<SOURCE format="xyz">
<TARGET format="ps"/>
<TARGET format="pdf"/>
<TARGET format="xyz"/>
</SOURCE>
</SUPPORTED_FORMATS>

b. Update the <CUSTOM> section with a new PROCESS element to have the process name ,
use the value obtained in Step 2.
<CUSTOM>
<PROCESS name="xyzProcess.exe" format="xyz" />
</CUSTOM>

8. Save the file.

9. Open the file \CTS\config\CTSPluginService.xml in any xml editor.

10. Make sure the following entry is available under <CTSPluginList> with other entries. If it is
not available, add the following line:
<CTSPlugin DELEGATE_CLASS="com.documentum.cts.plugin.defaultapp.DefaultAppPlugin"
CONFIGFILE="C:\PROGRA~1\DOCUME~1\CTS\config\defaultapp\defaultapp.xml"/>

11. Login to a WDK application (for example: Digital Asset Manager or Documentum Administrator)
as a superuser and navigate to: \System\Media Server\System Profiles.

12. Check out the "document_to_ps" profile.

13. Add a new Format section under <Formats> as follows. You must use the name attribute value
of dm_format of the format here:
<Formats>
:
<Format source="dm_format_name_here" target="ps"/>
</Formats>
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Make sure the following entry is available under <CommandFilePath> the section, regardless
of the sequence.
<CommandFilePath mptype="DefaultApp">
/System/Media Server/Command Line Files/document_to_ps.xml
</CommandFilePath>

14. Save and check in the file.

15. Restart the CTS Server Service.

To enable PDF transformation for ANY source format through DefaultApp+PDF/
AdvancedPDF Plugin for DTS/ADTS

1. Check out the document_to_pdf_via_ps.xml profile from \System\Media Server\System profiles
folder from the repository.

2. Add a new Format section under <Formats> as follows. You must use the name attribute value
of dm_format of the format here:
<Formats>

:
<Format source="dm_format_name_here" target="pdf"/>
</Formats>

3. Save and check in the file.

4. Restart the CTS Server Service.

To enable the new PDF transformation through Legacy Calls

1. Check out the legacy_to_pdf.xml profile from \System\Media Server\System profiles folder
from the repository.

2. Add a new Format section under <Formats> as follows. You must use the name attribute value
of dm_format of the format here:
<Formats>
:
<Format source="dm_format_name_here" target="pdf"/>
</Formats>

3. Add a new innerprofile section as follows:
<InnerProfile path="/System/Media Server/System Profiles/document_to_pdf_via_ps"
waitOnCompletion="false" useTargetFormat="true">
<InnerTokenMapping LocalProfileToken="pdf" InnerProfileToken="target_format"
Literal="true"/>
</InnerProfile>

4. Save and check in the file.

5. Restart the CTS Server Service.
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Retaining A4 paper size for MS Excel files
(ADTS)
Advanced Document Transformation Services retains the output size for A4 files; however, Microsoft
Excel must have the proper setting in order to preserve this printing size. Otherwise, A4 files might
be resized to letter size during transformation.

To retain A4 printing size in Microsoft Excel:

1. Launch Microsoft Excel on the ADTS host machine.

2. Select Tools > Options.
Click International.

3. Clear Allow A4/Letter paper resizing.

4. Click OK.
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Chapter 5
Configuration Tasks for Media
Transformation Services

The following sections detail configuration tasks that are specific to Media Transformation Services:
• Configuring the Image 3 plug-in, page 75

• PowerPoint configuration, page 77

• Configuring attribute inheritance for PowerPoint slides, page 78

Configuring the Image 3 plug-in
The Image 3 plug-in has some extra options — over and above the standard configuration options for
plug-ins — that can be configured through the plug-in’s configuration file. The following sections
detail these options and how they can be configured:
• ICC profiles, page 75

• COM Server parameters, page 76

• Pixel cache parameters, page 76

• Timeout configuration, page 77

ICC profiles

The ICC profiles section of the configuration file holds a list of individual ICC profiles. You can specify
one ICC profile per colorspace. An ICC profile is specified in an ICC_PROFILE_INFO XML tag:
<ICC_PROFILE_INFO profile_token="doc_token_cmyk_profile" colorspace="CMYK">
C:\Program Files\Documentum\CTS\Image3\required\color\USWebCoatedSWOP.icc
</ICC_PROFILE_INFO>

The value of the XML element is the fully qualified path to the ICC profile. The attributes are
as follows:
• profile_token – the token in the profile that will be substituted with the path of the ICC profile.

• colorspace – the colorspace of this profile.

Two ICC profiles will be used in conjunction to perform color conversions when doing
transformations.
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The Image 3 plug-in is configured out-of-the-box with a CMYK and RGB profile which will be used to
convert CMYK images to RGB when creating thumbnails and low-resolution JPEGs.

COM Server parameters

There are two configurable parameters relating to the COM Server:
• Process name

This is the name of the COM Server that performs the work based on the ImageMagick library. It
should always be IMW_COMServer.exe.

• Pool size

The value of this configuration parameter is the maximum number of ImageMagick COM servers
that can be running at one time.

Pixel cache parameters

A number of parameters can be configured for the pixel cache in the Image 3 plug-in.

Table 7. Pixel cache parameters for Image 3 plug-in

Parameter name Function XML attribute

Memory size Sets the maximum amount
of memory in megabytes to
allocate for the pixel cache from
the heap. When this limit is
exceeded, the image pixels are
cached to memory-mapped
disk.

doc_token_limit_memory

Memory map size Sets the maximum amount of
memory map in megabytes
to allocate for the pixel cache.
When this limit is exceeded, the
image pixels are cached to disk.

doc_token_limit_map

Area size Sets the maximum width
x height of an image that
can reside in the pixel cache
memory. Images that exceed
the area limit are cached to
disk.

doc_token_limit_area
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Timeout configuration

If your installation of Media Transformation Services will be processing large images, you may need
to configure the timeout value in the image3.xml configuration file. This value will determine how
long Media Transformation Services will maintain an image in its processes before calling a timeout
and causing the processing to fail.

Media Transformation Services requires at least 2 GB of free memory to process large images. If you
expect to process large dimensioned images, it may be necessary to raise the default timeout value,
taking your computer’s capabilities into consideration.

This value can be configured in the image3.xml file:

• application_monitor_timeout

This is the number of seconds to wait for an image file to process before terminating it and logging
the timeout. With the default of 10 minutes, this value appears as follows:

<APPLICATION_MONITOR_TIMEOUT>600</APPLICATION_MONITOR_TIMEOUT>

The timeout value should be based on the hardware on the machine in question, and the number
of and size of the images. If you are experiencing timeouts with this default value, you could
increase it in the config file.

PowerPoint configuration
There are a number of things that can be configured using the PowerPoint.xml configuration file.
The most important is the wait interval given to PowerPoint presentation processing. This value will
determine how long Media Transformation Services will maintain a presentation in its processes
before calling a timeout and causing the processing to fail. For example, if you expect to process
presentations with slides greater than 400, it may be necessary to raise the default wait interval value.

The following values can be configured in the PowerPoint.xml file:

• application_wait_interval

This is the number of seconds to wait for a PowerPoint file to process before terminating it and
logging the timeout. With the default of 20 minutes, this value appears as follows:

<APPLICATION_WAIT_INTERVAL>1200</APPLICATION_WAIT_INTERVAL>

The wait interval value should be based on the hardware on the machine in question, and the
number of slides in an average PowerPoint presentation. For example, for a Microsoft Windows
2000 Advanced Server with 1.048 GB RAM and an AMD Athlon™ (1.4 GHz) single processor
CPU, a timeout of 5 minutes per 100 slides may be appropriate.

• application_monitor

To enable monitoring, set this value to true. A value of false disables monitoring. Monitoring is
enabled when the value appears as:

<APPLICATION_MONITOR>true</APPLICATION_MONITOR>
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Configuring attribute inheritance for
PowerPoint slides
PowerPoint slides that are processed on import will inherit all possible attributes from the parent
presentation, with the exception of read-only, title, and name attributes. Exceptions to attribute
inheritance can be configured in the powerpoint_registration.xml command-line file, if
necessary.

The <COPY_ATTRIBUTES> node in powerpoint_registration.xml allows you to ignore
specific attributes. This node appears as follows:
<COPY_ATTRIBUTES>
<!--add here any attributes that should not be copied from
the document to the generated slides-->
<IGNORE>a_content_type</IGNORE>
<IGNORE>a_storage_type</IGNORE>
<IGNORE>title</IGNORE>
<IGNORE>object_name</IGNORE>
<IGNORE>a_last_review_date</IGNORE>
</COPY_ATTRIBUTES>
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Configuration Tasks for Audio/Video
Transformation Services

The following sections detail configuration tasks that are specific to Audio/Video Transformation
Services:
• Rich-media enabling formats for AVTS, page 79

• Configuring the Telestream FlipFactory Plug-in, page 80

• Configuring for Telestream FlipFactory distribution support, page 81

• Changing the number of threads for Telestream FlipFactory, page 82

• Configuring Telestream Flipfactory Notifier plug-in, page 83

• Configuring AVTS to create different default preview formats on import of Video files, page 83

• Changing dimension and frame rate for MPEG2 subclips, page 84

• Rendering video content from MPEG2 file, page 85

• Allowing watch folders to allow repeat register requests, page 85

• Content Server configuration required for large video files, page 85

• Configuring output format for MXF files, page 86

Rich-media enabling formats for AVTS
Follow this procedure to use media formats that are not already included with Audio/Video
Transformation Services:

To rich-media enable formats:

1. Run the following DQL statement:
update dm_format object set richmedia_enabled = 1 where
name in ('<format name>')

For example, to create thumbnails and storyboards for avi and Word formats, run the following
DQL statement:
update dm_format object set richmedia_enabled = 1 where
name in ('avi','jpeg')
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Table 8, page 80 lists some examples of the format mapping used in Documentum systems. Use
these format names in DQL.

Table 8. Documentum format mapping for Audio/Video Transformation Services

Extension Description Documentum name

AVI Video for Windows avi

MPG MPEG Video File mpeg

MOV QuickTime Movie quicktime

RM RealMedia File rm

MPG2 MPEG2 Video File mpeg2

wmv Windows Media Video wmv

Configuring the Telestream FlipFactory Plug-in
The Telestream plug-in has been optimized by default for long duration video and optimal memory
usage. There is also an option to limit the number of key frames which adjusts the key frame
extraction interval.

To process long video (typically longer than 30 minutes), the following configuration parameters
should be considered:

• MaxTaskThreadJobTime in %CTS_HOME%\config\CTSServerService.xml

The recommended value is at least 2 to 3 times the expected maximum video length, depending
on the system resources available. If there is the possibility of multiple video processing at the
same time, this value should be increased more. The value is specified in minutes.

Note: A larger value for MaxTaskThreadJobTime means that CTS cannot detect possible system
hang within that period.

• MAX_RETRIES in %CTS_HOME%\config\tls\tls.xml

At least 60 to 120 is recommended for video longer than 30 minutes depending on the system
resources available.

Note: A larger value for MAX_RETRIES means that CTS cannot detect possible FlipFactory hang
within that period. (MAX_RETRIES * SLEEP_TIME)

• MAX_KEYFRAMES in %CTS_HOME%\config\tls\tls.xml

The key frame interval for importing is defined in the command-line file telestream_
registration.xml located in the repository at System\Media Server\Command Line Files.
<capture name="Capture Mode" type="exclusive">Repeat</capture>
<interval name="Capture Time/Interval" type="time">00:00:01:00
</interval>

However, for longer video, the large number of key frames could cause significant system
performance degradation, so the number of key frames can be limited using this value
(MAX_KEYFRAMES). If the number of key frames could exceed this value, the key frame interval
is adjusted automatically according to it.
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If this value is 0 or negative, the original interval will be preserved.

Configuring for Telestream FlipFactory
distribution support
Using FlipFactory distribution, Audio/Video Transformation Services transformation results can be
delivered to a designated video server or video editing suite and archived contents can be delivered.

To support FlipFactory distribution, the destination information must be configured in the protocol
information (the protocol.xml file in the CTS installation directory, for example, C:\Program
Files\Documentum\CTS\tls\protocol.xml). It is highly recommended to test the available
destinations using the FlipFactory console before requesting transformations with distribution
through CTS.

For some destinations, the Flip Engine service must be running under an account that has sufficient
privileges to access the server. For details on specifying logon accounts or setting up authentication
for network shares in the registry, see the FlipFactory User’s Guide.

Sample FTP configuration in protocol.xml:
<protocol name="File Transfer Protocol (FTP)" role="source"
seperator="/"type="ftp" protocol_id="ftp_01">
<connection name="FTP Server" type="push">
<delete name="Replace existing files?" type="boolean">false</delete>
<host name="Server Name" type="domain">FTPServer</host>
<port add="1" max="65535" min="20" name="TCP/IP Port" type=
"variable">21
</port>
<passive name="Passive Mode" type="boolean">false</passive>
<username name="Login" type="username">login</username>
<password name="Password" type="password">password</password>
<path file-select="path" name="Default Path" type="file"></path>
<removeExt name="Remove File Extension" type="boolean">false</
removeExt>
<verboseList name="Verbose Listings" type="boolean">false
<listing name="Listing Style" type="exclusive">Unix</listing>
<listing name="Listing Style" type="exclusive">DOS</listing>
</verboseList>
<alias name="Alias URL" type="text"></alias>
</connection>
</protocol>

Encrypting your credential information in protocol.xml

You can encrypt your login credentials using the TLSEncryptProtocol
tool (located in the CTS installation directory, for example, C:\Program
Files\Documentum\CTS\tls\TLSEncryptProtocol.bat). This encryption is valid on the same
machine. If you have multiple AVTS instances, you must repeat this encryption for each machine.

Usage: TLSEncryptProtocol protocol_path protocol_id node_name value

For example: TLSEncryptProtocol protocol.xml ftp_01 password your-password
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Adding more destinations using the same protocol

If you have multiple FTP servers, you need to configure them in the profiles and the protocol
information.

For each applicable transformation profile found in the repository under \System\Media
Server\Profiles (for example, to_wmv.xml), add your FTP servers under the ValueList entry. For
example, for an FTP server named FTP Server II, add "<Value label="FTP Server II">ftp_02</Value>"
as a child of the <ValueList> node.

The following is an example of the ValueList entry with multiple FTP servers:
<Parameter name="doc_token_protocol" label="Deliver the result To"
controltype="list" datatype="string">

<ValueList>
...

<Value label="FTP Server I">ftp_01</Value>
<Value label="FTP Server II">ftp_02</Value>

...
</ValueList>

You must also add the protocol information to the protocol.xml file in the CTS installation
directory, for example, C:\Program Files\Documentum\CTS\tls\protocol.xml. The
following is an example of the information you may add for ftp_02.
<protocol name="File Transfer Protocol (FTP)" role="source" seperator=
"/" type="ftp" protocol_id="ftp_02">
...
</protocol>

Changing the number of threads for Telestream
FlipFactory
To increase the number of processing jobs, you can increase the number of threads for Telestream
FlipFactory. Of course, the performance gained from increasing the number of threads depends
on the processing power of your machine. You can change the number of threads using either of
the following two methods.

To change the number of threads using the FlipFactory user interface:

1. Select System Settings.

2. Select Flip Server Limit and set the value for number of threads.

To change the number of threads using the Registry Editor:

1. Open the Windows Registry Editor (go to Start > Run > regedit).

2. Scroll to the line:
[HKEY_LOCAL_MACHINE\SOFTWARE\JavaSoft\Prefs\net\telestream\flip\
servers\localhost]@="
”limit”=”10”
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3. Change the limit value to the required number.

Configuring Telestream Flipfactory Notifier
plug-in
The Flip Factory Notifier Plugin allows you to use the "Video standard parameter" from the notifier
plugin UI, in the event that one video type is ingested from the monitored folder. The "Video
standard parameter" is the video library used to extract frame rate/video standard and is located at:
%Telestream%\FlipFactory\Plugins\com\documentum\ffplugin\notify\DCTMIngestNotify.
properties.

By default, "UseVideoStandardParam” is set to "false” and the notifier UI will not display the "Video
standard parameter". Video properties will not be extracted from the file.

Note: You cannot change the behavior of a factory once it is created. A new factory is required
if the parameter value is switched.

Updating the Windows registry

You need to update the Windows registry at HKEY_LOCAL_
MACHINE\SYSTEM\CurrentControlSet\Services\Flip Engine\Parameters.

• Add the path ’C:\Program Files\Documentum\CTS\lib\cts.jar’ to the value of the parameter
’JVM Option Number x’ that specifies the "-Djava.class.path" option.

• Add the path ’C:\Program Files\Documentum\CTS\lib’ to the value of the parameter ’JVM
Option Number x’ that specifies the "-Djava.library.path" option.

Configuring AVTS to create different default
preview formats on import of Video files
Out of the box, AVTS creates Flash 9 renditions for the default preview rendition of video files.
This can be changed to either WMV, MPEG4 or QT Streaming format. Some profile changes are
required to set the default preview rendition to another format. For example, in order to configure
AVTS to generate ‘QT Streaming’ format as the default preview, instead of ‘Flash 9’, the following
profile changes are required.

To configure Audio/Video Transformation Services for a different default preview
format:

1. Check out the register profile from the ‘\System\MediaServer\System Profiles’ folder in
the repository.

2. Change the following section so that the default_proxy_format attribute value will be changed
from f4v to quicktime
Replace:
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<InnerProfile path="/System/Media Server/System Profiles/telestream_registration"
waitOnCompletion="false">

<InnerTokenMapping LocalProfileToken="f4v" InnerProfileToken=
"default_proxy_format"
Literal="true"/>

<InnerTokenMapping LocalProfileToken="true" InnerProfileToken=
"overwrite_rendition"
Literal="true"/>

</InnerProfile>

With:
<InnerProfile path="/System/Media Server/System Profiles/telestream_registration"
waitOnCompletion="false">

<InnerTokenMapping LocalProfileToken="quicktime" InnerProfileToken=
"default_proxy_format" Literal="true"/>

<InnerTokenMapping LocalProfileToken="true" InnerProfileToken=
"overwrite_rendition" Literal="true"/>

</InnerProfile>

3. Check in the register profile.

4. Check out the telestream_registration.xml command line file from the
‘\System\MediaServer\Command Line Files’ folder in the repository.

5. Comment out the <product> section tag that corresponds to ‘Flash 9’ and uncomment the
<product> section tag that corresponds to ‘QuickTime Streaming’.

6. Check in the telestream_registration.xml file.

7. Restart CTS windows service.

Changing dimension and frame rate for MPEG2
subclips
Audio/Video Transformation Services can render video subclips for subclips with MPEG2 parents.

By default, dimension and frame rate for the subclips are limited by 720x480 and 29.97 FPS. If
your needs require a different dimension and frame rate, you must change the command line
file render_subclip_mpg.xml. The file can be found on the AVTS configured repository in
System\Media Server\Command Line Files.

Under <SUBCLIP_OPTIONS>, locate the <setup> node and edit the frame-width, frame-height,
and frame-rate values according to your needs:
<setup>
<frame-width name="Frame Width" unit="pixels" min="80"
max="720">720
</frame-width>
<frame-height name="Frame Height" unit="pixels" min="60"
max="512">480
</frame-height>
<frame-rate name="Frame Rate" unit="frames/second">29.97
</frame-rate>
<channels name="Audio Channels" unit="channels">2</channels>
<sample-rate name="Audio Sample Rate" unit="Hz">48000</
sample-rate>
</setup>
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Rendering video content from MPEG2 file
To avoid getting an error message when rendering video content from an MPEG 2 file, perform the
following steps:

1. Play an MPEG 2 file on the Audio/Video Transformation Services host using Windows Media
Player.

2. If a Windows Media Player dialog box appears stating the file format is not recognizable and asks
you to confirm that you want to play the file:

a. Select the checkbox next to "Don’t ask me again for this extension.”

b. Click Yes.

c. Play the MPEG 2 file again to ensure the file plays without any further prompts.

d. Restart the CTS server.

Allowing watch folders to allow repeat register
requests
Customers who import a large number of video files may choose to import all video asset using a
watch folder. To avoid double processing of video assets the keyword "ignore_cts_processing" is
applied to all asset ingested through the watch folder. This avoids double transforming assets.
However, once the video asset is successfully imported the user may need to reset the rendition for
the file, which will not be permitted by the "ignore_cts_processing" keyword.

A configuration option has been provided to allow the flag to ignore register requests to be used only
once. If the configuration option is removed the flag will be permanent and no further register
requests will be processed (like reset-rendtions or checkins). This configuration can be applied in the
file %CTS%\config\CTSServerService.xml:

1. Locate all the QueueProcessorContext nodes, such as <QueueProcessorContext
DocbaseName="repository">

2. For each of these nodes add this child node: <CTSServer AttributeName=
"ignoreKeywordRemoval" AttributeValue="YES"/>

Content Server configuration required for large
video files
When importing a video file larger than 2.5 GB, the renditions, thumbnail, and storyboard are not
created. The Content Server must be configured to allow processing of files larger than 2.5 GB.
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To configure Content Server for transforming video files larger than 2.5 GB:

1. Locate the file server.ini at the following location:
• On Windows, %DOCUMENTUM%\dba\config\<repository>

• On Unix, $DOCUMENTUM/dba/config/<repository>

2. Open the file in a text editor.

3. Locate the section [SERVER_STARTUP].

4. Add the client_session_time key and a value for timeout_in_minutes. The value for
timeout_in_minutes should be at least twice your expected maximum video duration, depending
on the machine’s performance.
For example, for a largest expected video size of 2 GB, set it to:
client_session_timeout = 120

5. Restart the Content Server and CTS.

Configuring output format for MXF files
Out of the box, MXF is included in the register process and on import, a Flash9 rendition is generated.

Manual profile updates are required if you would like to decode the source to any other format. To
process it during registration (that is, thumbnail/proxy/storyboard generation) no manual steps
are required.

To get other transformed output as part of a profile request for MXF files:

1. Install the Telestream FlipFactory patch, EMC_jp2000_support_7_1_64133.zip, available on
the EMC Download Center.

2. In the AVTS configured repository, check out the profile corresponding to the encoding target
format. For example, to convert to Flash8 format, select the to_flash.xml profile from
\System\Media Server\Profiles folder.

3. Add the following format entry under the <Formats> section:
<Format source="mxf" target="flv"/>

4. Check in the profile.

5. Restart CTS server.
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Transformation Services

The following sections detail configuration tasks that are specific to XML Transformation Services:
• Configuring filters, page 87

• Configuring XTS with custom style sheets, page 94

• Configuring XTS to transform XML content, page 96

• Configuring a custom XSLT processor, page 97

Configuring filters
Filters allow you to configure the output to include or exclude specific content that has been tagged
within the source document. For example, a user guide may have content that applies to specific
operating systems on which the application is installed. If the content pertaining to those operating
systems is tagged as such within the source file, the output can be filtered accordingly.

XML Transformation Services is configured out of the box with the following four filters:
• profile_os

The following operating systems are available: Windows, Linux, HP-UX, Solaris, and Mac.

• profile_audience

The following audience levels are available: Expert, Intermediate, and Beginner.

• profile_revision

The following revision names are available: New, Changed, Deleted, and Final.

• profile_product

No names exist for this filter. You must add the product names that apply to your organization.

If any of these default filters are appropriate for your organization, you must ensure that the source
documents are profiled accordingly. To use the operating system profile, for instance, you must tag
sections within your source documents with operating system names. Consult the documentation for
your authoring system to determine how to profile your source documents.

For many organizations, these filters will require modification, or new filters will be needed.
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One transformation profile controls all DITA filters, while three different profiles are required for
DocBook transformations. Separate procedures are provided for both DITA and DocBook filter
configurations.

This section covers the following topics:
• Adding product names to the product filter, page 88

• Configuring other DITA filters, page 89

• Using inclusion mode for DITA filters , page 91

• Configuring other DocBook filters, page 92

Adding product names to the product filter

Since each organization will have a unique set of product names for which to filter, you must add the
appropriate product names to the transformation profiles.

Note: By default, the profiles have no product names specified. If you do not add product names
as outlined below, users can simply enter the product name in a text box when they perform
transformations. However, this approach could lead to user errors if incorrect product names are
entered. Configuring the product names in the profiles is highly recommended.

To add product names to appear in the product filter list box:

1. Log in to the repository using an appropriate application.

2. Navigate to /System/Media Server/Profiles.

3. Check out or export the ProfileSchema.dtd file.
If you export the file, you only need to do so the first time you modify a profile. Leave the DTD file
in your checkout directory so that the profiles you check out in the future can reference the DTD.

4. Check out the appropriate profile:
• For all DITA transformations, select dita_transform.xml.

• For DocBook transformations, select the docbook_transform_chm.xml,
docbook_transform_html.xml, or docbook_transform_pdf.xml, depending on the
transformations your organization will be using.

Note: If these files are not immediately visible, select Show All Objects and Versions from the
Show list box.

5. Open the profile in an XML or text editor.

6. Locate the profile_product parameter. Change the controltype from "text” to "listbox”.

7. Add <ValueList> tokens to the profile_product parameter.
For example, if you want to filter content based on model number, you could add values as
follows:
<Parameter name="profile_product"

label="Product Filter"
controltype="listbox"
datatype="string"
isRequired="false"
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description="Select any Products You wish...">
<ValueList>
<Value label="Model A">Model A</Value>
<Value label="Model B">Model B</Value>
<Value label="Model C">Model C</Value>
<Value label="Model D">Model D</Value>
</ValueList>
</Parameter>

8. Save your changes.

9. Check in the profile.

10. Stop and restart the transformation server service.
The correct product names will now appear in the product list box when users are requesting
transformations.

Configuring other DITA filters

The dita_transform.xml profile file controls the filters for all DITA transformations.

To modify an existing DITA filter:

1. Log in to the repository using an appropriate application.

2. Navigate to /System/Media Server/Profiles.

3. Check out or export the ProfileSchema.dtd file.
If you export the file, you only need to do so the first time you modify a profile. Leave the DTD file
in your checkout directory so that the profiles you check out in the future can reference the DTD.

4. Check out the dita_transform.xml file.

Note: If this file is not immediately visible, select Show All Objects and Versions from the
Show list box.

5. Open the profile in an XML or text editor.

6. Locate the filter parameter you wish to modify within the <Transcodings> section.
For example, the revision filter appears as follows:
<Parameter name="profile_revision"

label="Revision Filter"
controltype="listbox"
datatype="string"
isRequired="false"
description="Select Any Revision Flags You Wish to

Exclude">
<ValueList>
<Value label="New">New</Value>
<Value label="Changed">Changed</Value>
<Value label="Deleted">Deleted</Value>
<Value label="Final">Final</Value>
</ValueList>
</Parameter>

7. Add, modify, or delete a value within the list, being careful to follow the proper syntax.
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For example, you could change the values for profile_revision, as follows:
<Parameter name="profile_revision"

label="Revision Filter"
controltype="listbox"
datatype="string"
isRequired="false"
description="Select Any Revision Flags You Wish to

Exclude">
<ValueList>
<Value label="First draft">First draft</Value>
<Value label="Technical review">Technical review</Value>
<Value label="Approved">Approved</Value>
</ValueList>
</Parameter>

8. Save your changes.

9. Check in the profile.

10. Stop and restart the transformation server service.
The modified values will now appear when users request transformations for DITA files.

To add a new filter for DITA source files:

1. Log in to the repository using an appropriate application.

2. Navigate to /System/Media Server/Profiles.

3. Check out or export the ProfileSchema.dtd file.
If you export the file, you only need to do so the first time you modify a profile. Leave the DTD file
in your checkout directory so that the profiles you check out in the future can reference the DTD.

4. Check out the dita_transform.xml file.

Note: If this file is not immediately visible, select Show All Objects and Versions from the
Show list box.

5. Open the profile in an XML or text editor.

6. Add a parameter for the filter you wish to add.
For example, to add a filter based on application servers, the new parameter might appear as
follows:
<Parameter name="profile_appserver"

label="Application Server Filter"
controltype="listbox"
datatype="string"
isRequired="false"
description="Select an application server to exclude">

<ValueList>
<Value label="BEA">BEA</Value>
<Value label="Oracle">Oracle</Value>
<Value label="Sun One">Sun One</Value>
<Value label="Tomcat">Tomcat</Value>
</ValueList>
</Parameter>

7. New or existing filters can also have a blank value, to be used in ’inclusion’ mode. Under
<ValueList> node add a line such as the following:
<Parameter name="profile_appserver"
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label="Application Server Filter"
controltype="listbox"
datatype="string"
isRequired="false"
description="Select an application server to exclude">
<ValueList>
<Value label=" "> </Value>
<Value label="BEA">BEA</Value>
<Value label="Oracle">Oracle</Value>
<Value label="Sun One">Sun One</Value>
<Value label="Tomcat">Tomcat</Value>
</ValueList>
</Parameter>

Note: The value itself cannot be empty. Use at least one blank space.

8. Save your changes.

9. Check in the profile.

10. Navigate to /System/Media Server/Command Line Files.

11. Check out the dita_transform_command.xml file.

Note: If this file is not immediately visible, select Show All Objects and Versions from the
Show list box.

12. Open the profile in an XML or text editor.

13. In the <input_properties> section, add the new filter. This illustrates the entry for the application
server example:
<!-- property maps to the 'profile_appserver' parameter
- used as a conditional processing filter

(default value '' indicates that there are no
filter tokens) -->
<property name="profile_appserver" value=""/>

14. In this same file, add an entry to the <conditional_params> section. Continuing the application
server example, this addition would appear as follows:
<param name="appserver" use-property="profile_appserver"/>

15. Save your changes.

Note: If this file is not immediately visible, select Show All Objects and Versions from the
Show list box.

16. Check in the profile.

17. Stop and restart the Content Transformation Services service.
The new filter will now appear when users request transformations for DITA files.

Using inclusion mode for DITA filters

By default, XTS excludes the conditional content based on selected filters in the Transformation
Wizard interface. There may be cases where a customer wants to specify what content should be
included. Configuration is required to support such a scenario. Once the change is in place all
transformation will use filtering in "inclusion” mode.
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This feature works with DITA OT 1.4.2 or above. While in ‘inclusion’ mode, if you need to tell XTS
not to include any content that is tagged with the specified filter, you will need to add a blank value
to the profile parameter associated with that filter.

To configure inclusion mode for DITA conditional processing:

1. Log in to the repository using an appropriate application.

2. Navigate to /System/Media Server/Command Line Files.

3. Check out the dita_transform_command.xml file.

Note: If this file is not immediately visible, select Show All Objects and Versions from the
Show list box.

4. Open the profile in an XML editor.

5. Uncomment the following line:
<property name="cond_proc_action" value="include"/>

6. Save your changes.

7. Check in the profile.

8. Stop and restart the Content Transformation Services service.

Configuring other DocBook filters

Three profile files handle DocBook transformations, based on the output format:
• docbook_transform_chm

• docbook_transform_html

• docbook_transform_pdf

Each of these profiles contains a unique set of parameters. They also include the standard four
filters as for DITA files.

To modify an existing DocBook filter:

1. Log in to the repository using an appropriate application.

2. Navigate to /System/Media Server/Profiles.

3. Check out or export the ProfileSchema.dtd file.
If you export the file, you only need to do so the first time you modify a profile. Leave the DTD file
in your checkout directory so that the profiles you check out in the future can reference the DTD.

4. Check out the docbook_transform file you wish to modify.

Note: If these files are not immediately visible, select Show All Objects and Versions from the
Show list box.

5. Open the profile in an XML or text editor.

6. Locate the filter parameter you wish to modify within the <Transcodings> section.
For example, the audience filter appears as follows:
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<Parameter name="profile_audience"
label="Audience Filter"
controltype="listbox"
datatype="string"
isRequired="false"
default="">

<ValueList>
<Value label="Expert">Expert</Value>
<Value label="Intermediate">Intermediate</Value>
<Value label="Beginner">Beginner</Value>
</ValueList>
</Parameter>

7. Add, modify, or delete a value within the list, being careful to follow the proper syntax.
For example, you could change the values for profile_audience, as follows:
<Parameter name="_audience"

label="Audience Filter"
controltype="listbox"
datatype="string"
isRequired="false"
default="">

<ValueList>
<Value label="User">User</Value>
<Value label="Administrator">Administrator</Value>
<Value label="Developer">Developer</Value>
</ValueList>
</Parameter>

8. Save your changes.

9. Check in the profile.

10. Stop and restart the Content Transformation Services service.
The modified values will now appear when users request transformations for DocBook files.

To add a new filter for DocBook source files:

1. Log in to the repository using an appropriate application.

2. Navigate to /System/Media Server/Profiles.

3. Check out or export the ProfileSchema.dtd file.
If you export the file, you only need to do so the first time you modify a profile. Leave the DTD file
in your checkout directory so that the profiles you check out in the future can reference the DTD.

4. Check out the docbook_transform file for which to add a filter.

Note: If these files are not immediately visible, select Show All Objects and Versions from the
Show list box.

5. Open the profile in an XML or text editor.

6. Add a parameter for the filter you wish to add.
For example, if your documents contain different regulatory statements pertaining to different
countries, you might require a country filter. Such a parameter might appear as follows:
<Parameter name="profile_country"

label="Country Filter"
controltype="listbox"
datatype="string"
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isRequired="false"
description="Include content specific to this country">

<ValueList>
<Value label="USA">USA</Value>
<Value label="Canada">Canada</Value>
<Value label="Mexico">Mexico</Value>
</ValueList>
</Parameter>

7. Save your changes.

8. Check in the profile.

9. Navigate to /System/Media Server/Command Line Files.

10. Check out the docbook_transform_command.xml file.

Note: If this file is not immediately visible, select Show All Objects and Versions from the
Show list box.

11. Open the profile in an XML or text editor.

12. In the <input_properties> section, add the new filter. This illustrates the entry for the country
example:
<!-- property maps to the 'profile_country' parameter
- used as a conditional processing filter

(default value '' indicates that there are no
filter tokens) -->
<property name="profile_country" value=""/>

13. In this same file, add an entry to the <conditional_params> section. Continuing the country
example, this addition would appear as follows:
<param name="country" use-property="profile_country"/>

14. Save your changes.

15. Check in the profile.

16. Stop and restart the Content Transformation Services service.
The new filter will now appear when users request transformations for DocBook files.

Configuring XTS with custom style sheets
This procedure allows you to configure XML Transformation Services with custom style sheets.
This is required to transform custom XML schema to PDF or HTML ("Transform XML to HTML"
or "Transform XML to PDF" profiles). Also, additional profile parameters may be required. The
following procedures include these configurations and parameters.

Caution: Make sure your custom XSL is compliant with the configured XSLT processor.

To configure XTS with custom style sheet:

1. Open the %CTS_HOME%\config\xpub.xml file.

2. Locate the <STYLESHEET> section.
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3. Update the <STYLESHEET> node corresponding to "XML" handler to point to the new file on
your local system.
<STYLESHEET handler="XML" name="DEFAULT" fileref="C:\PROGRA~1\
DOCUME~1\CTS\xts\xsl\default.xsl">

4. You can also add additional styles sheets for a handler and control which one to use via the
"use_stylesheet" profile parameter.
For example, you can have the following :
<STYLESHEET handler="XML" name="DEFAULT" fileref="C:\PROGRA~1\DOCUME~1\CTS\xts\
xsl\default.xsl">
<STYLESHEET handler="XML" name="MY_TRANSFORM1" fileref="C:\myxsl\transform1.xsl">
<STYLESHEET handler="XML" name="MY_TRANSFORM2" fileref="C:\myxsl\transform2.xsl">

5. Check-out the corresponding profile and add a new parameter named "use_stylesheet”.
The following example matches the style sheets from the previous step:
<Parameter name="use_stylesheet" label="Style Sheet" controltype="listbox"
datatype="string" isRequired="false">
<ValueList>
<Value label="Transform using my_transform1.xsl">MY_TRANSFORM1</Value>
<Value label="Transform using my_transform1.xsl">MY_TRANSFORM2</Value>

</ValueList>
</Parameter>

Note: The values in the list are the same as the values in the attribute ‘name’ of the
<STYLESHEET> nodes mentioned in Step 4.

6. Check-in the profile and save xpub.xml.

7. Restart the Content Transformation Services service.

To configure additional parameters for transforming custom XML:

1. Check out the profile (for example, "xml_transform_pdf.xml”) from the following folder in
the repository: /System/Media Server/Profiles.

2. Open the profile in an XML or text editor.

3. Locate the <Transcoding> tag and add the new parameter(s) as required.

4. Save and check in the file.

5. Check out the command line file (for example, "xml_transform_pdf_command.xml”) from
the following folder in the repository: /System/Media Server/Command Line Files.

6. Locate the xslt_params section (for example, <xslt_params format="pdf">). For each of the
parameters that you add in Step 3, add a new tag, using the new parameter name:
<param name="new_xslt_param_name1" use-property=" new_xslt_param_
name1"/>
<param name="new_xslt_param_name2" use-property=" new_xslt_param_
name2"/>
</xslt_params>

7. Save and check in the file.

8. Restart the Content Transformation Services service.
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Configuring XTS to transform XML content
There are scenarios where XTS should be configured in order to handle transformations successfully
and to the desired outcome. Some examples of such cases would be switching graphic files to
different resolution or removing unsupported characters from file names and references.

Follow this procedure if your XML content (e.g. DITA) requires special processing:

To configure XTS to transform XML content:

1. Locate and open the following file %CTS%\config\xpub\xpub.xml.

2. Locate the section <PATCHING_CONFIG>

3. From the <PARSE> sub node, select the required attributes:
• xpath

Represents an Xpath expression to an XML element that should be parsed.

• handler

Represents the type of XML document being processed.

• link_type

Represents the type of reference. For DRL patching, the value is conref; for graphics patching
the value is image; for special characters patching, the value is specialchar.

• patcher

Specifies a java class that processes the XML element.

• source

Specifies the content origins for which processing should occur. Possible values are "repo”,
"file”, and "any”.

4. From the <FILE_FILTER> node, select the required attribute:
• extension

Lists file extensions of XML content that should be processed.

5. Select the <IMG_PATCHING> node if graphics references should be processed. This is used to
map graphics in the original content to a repository rendition that will replace them. Select the
required attributes:
• <CONFIG> sub-node:

— target – target format (file extension, not documentum dm_format) of transformation

— handler – type of XML content (see 3-second bullet)

• <IMAGE_REF > sub-node:

— source_ext

represents the extension of graphic asset file to be replaced

— rend_dctm_format

represents the documentum format of the rendition that should replace the original file
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— rend_flag

specifies the flag value to identify a rendition

— rend_flag_type

Represents the flag type to be checked when used with rend_flag.

Possible rendition attributes are: page_modifier, rendition_name, or rendition_
description_name. You can also leave the space empty, in which case the first rendition
to match the requested format is selected.

Note: This features applies only if XTS is used combination with Media Transformation Services.
Media Transformation Services is needed to generate renditions for graphic assets.

6. For DRL Patching, select the <DRL_PATCHING> section. Select the required attributes:
• from <PARAM> nodes:

— brokenlink

Specifies a repository location for a DITA document that serves as a broken link page

— depth

Controls how many levels should be processed when XML files are being exported as
part of processing an existing one.

— special_chars

Lists special characters (separated by ‘/’) that should be replaced with ‘_’ in XML file
names and references.

7. Restart the Content Transformation Services service.

Configuring a custom XSLT processor
The profile xml_transform_html (label "Transform XML to HTML") allows you to perform XML
(custom schema) to HTML transformation via XSL. The transformation needs an XSLT file. A
default/sample file is provided by default under %CTS_HOME%\config\xpub. Configurations
related to this transformation are in %CTS_HOME%\config\xpub\xpub.xml under doc_type
"XML2HTML". Customers must provide their own XSL and configure it under <STYLESHEET
handler="XML2HTML" name="DEFAULT" fileref="....."/>. Multiple XSL files can be configured for
XML to HTML.

The XSLT processor can be configured at the Plug-in level or at the Profile level. Profile level will
over write the Plug-in level.

Configuring the XSLT processor at the plugin level:

1. Make a backup of the file xpub.xml located at %CTS%\config\xpub.

2. Open xpub.xml in an xml or text editor.

3. Locate the node //XML_TRANSFORM_CONFIG/XML_PROPERTIES and add (or edit)
XML_PROPERTY child. The following example is the default value for Saxon 6.x:
<XML_PROPERTY name="transformer_factory" value="com.icl.saxon.TransformerFactoryImpl"/>
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Note: Attribute ’name’ should always be "transformer_factory".

Note: Attribute ’value’ should be the desired implementation of javax.xml.transform.
TransformerFactory.

4. Save and close xpub.xml.

5. Restart the XML Transformation Services server.

Configuring the XSLT processor at the transformation level:

1. In the repository, navigate to the command line file used for the transformation (for example,
/System/Media Server/Command Line Files/xml_transform_pdf_command.xml).

2. Checkout the command line file.

3. Open the command line file in an xml or text editor.

4. Locate the node //xml_transform_command/input_properties/transformer_factory (add it if
missing)

5. Set the attribute ’classname’ with the desired implementation of javax.xml.transform.
TransformerFactory like in the following example (using Saxon 9.x):
<transformer_factory classname="net.sf.saxon.TransformerFactoryImpl" />

6. Save and close the command line file and check it back in to the repository.

7. Restart the XML Transformation Services server.

Altering the classpath for the new processor:

1. Deploy the libraries on %CTS%\lib.

2. Edit the MANIFEST.MF inside %CTS%\lib\xts.jar\META-INF by appending the new
libraries to the end. Make sure you follow the required protocol when listing jars: the list of jars is
within cols [1-70]; jars are separated by 2 spaces.

Note: MTS and ADTS are not compatible with Saxon XSLT processor. As such, any new
XLST that is deployed to XTS should be configured as described above. Then, the \META-
INF\services\javax.xml.transform.TransformerFactory entry should be removed from any jar
containing it, in order to prevent such a library to "broadcast" itself as an XSLT processor.

98 EMC Documentum Content Transformation Services Transformation Suite Version 6.7 Administration Guide



Chapter 8
Administering Content Transformation
Services Web Services

This chapter contains the following information:

• What are CTS WebServices, page 99

• Web services and Document Foundation Services (DFS), page 101

• CTS WebServices architecture , page 101

• Asynchronous and synchronous transformation, page 103

• Deploying CTS WebServices in a supported application server, page 104

• Configuring CTS WebServices, page 104

• CTS WebServices log file, page 104

What are CTS WebServices
CTS WebServices is based on Documentum Foundation Services platform. It provides synchronous
realtime transformation capabilities. Any client application based on CTS WebServices may request
transformations that result in files that are available directly to the client, with minimal turn around
time.

Documentum Content Transformation Services provides two web services as an extension of its
features for asynchronous and synchronous transformation and analysis: Profile service and
Transformation service. Each service provides a set of operations on repository objects and are
extended with services that provide additional platform functionality.

• Web services are WSDL based.

• Web services are remote or local.

• Web services are ready to deploy via J2EE standards (ear and war files).

Profile service

The profile service provides an interface to CTS transformation profiles. The profile service enables
applications to obtain available transformation profiles using various filtering mechanisms, as well as
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to update them if suitable permissions are held by the application session. This section describes the
operations related to the Profile service. Operations related to Transformation service follow.

For further details about the structure of each operation, such as sample java code and methods, see
EMC Documentum Enterprise Content Services Reference guide.

Operations related to this service
Note: You need Administrator privileges to perform: addProfile operation; removeProfile operation,
and updateProfile operation.

addProfile operation

The addProfile operation adds a CTS profile to the repository from the client where the profile is
saved.

addProfiles operation

The addProfiles operation adds multiple profiles including command line files, user profiles, and
system profiles to the repository from the client.

getProfileById operation

The getProfileById operation is used to get a specific profile which is queried by its saved Profile Id.

getProfileByName operation

The getProfileByName operation is used to specify which profile should be invoked to process a
source object. The profile is queried by the saved profile name and repository location. For example,
only the profile with the id "flip” will process the source object

getProfiles operation

The getProfiles operation is used to get an array of profiles which satisfy the query that specifies
conditions passed with prParam.

removeProfile operation

This removeProfile operation removes a profile with a specific profileId. All versions of the profile
will be removed, if specified.

updateProfile operation

The updateProfile operation updates a specified saved profile.

Transformation service

The transformation service provides an interface to CTS transformation capabilities. The
transformation service enables applications to request transformations from the Content
Transformation Services suite of products in both synchronous and asynchronous modes. The
following section describes the operations related to the Transformation service.

For further details about the structure of each operation, such as sample java code and methods, see
EMC Documentum Enterprise Content Services Reference Guide.
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Operations related to this service

addJob operation

The addJob operation creates an asynchronous transformation job in the repository and returns a
Job Id for tracking purposes.

cleanUpJobs operation

The cleanUpJobs operation deletes all the transformation related objects by a specified date.

deleteJob operation

The deleteJob operation deletes only a specific transformation by JobId before it is processed. If the
job has already started, it will not be deleted

getJobInfo operation

The getJobInfo operation queries the job details of a requested transformation based on the Job Id.
This operation provides the job status about the specified object, for example, getJobInfo will inform
if the job is pending, in progress, failed, or complete.

importAndAddJob operation

The importAndAddJob operation submits a transformation request on a source file to the CTS server
asynchronously. The user submits the source file which is imported to the repository from the client’s
machine prior to adding it to the queue for transformation

transformJob operation

The transformJob operation submits a transformation request directly to the CTS server
synchronously. The call is made directly to the CTS server and you get the result back.

Web services and Document Foundation
Services (DFS)
Document Foundation Services (DFS) delivers a set of core Enterprise Content Services which
are deployed with Content Server where they are hosted by the Java Method Server. DFS is a
multifaceted technology set used for developing and deploying ECM services and consumers using a
service-oriented architecture.

For more information on the DFS, see the Document Foundation Services User Guide.

CTS WebServices architecture
A CTS web service request involves the exchange of messages amongst three parties: the service
provider (server) and requestor (the client) and infrastructure components. Communication between
client and server is accomplished through a request/response mechanism. Service requests and
responses are wrapped in XML documents and transferred using Hypertext Transfer Protocol
(HTTP). When the client issues a request to a service, it goes through a Load Balancer and Web
Service Layer. The load balancer determines which CTS instance is capable of providing the service
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for a given request. It employs a Java servlet which executes the desired action and sends the results
back to the client. To minimize the required bandwidth between server and client, the servlets
perform several actions within the scope of one request and merge the results so that the operation
appears to be just one single action.

Figure 5. CTS WebServices Architecture

1. Web services architecture is based on the SOAP protocol. The client sends a request for a
document transformation invoking the web service. The use of WSDL allows the interoperability
between services from different sources.

2. The requester relies on the load balancer using a heartbeat mechanism to find the appropriate
instance.

• The load balancer is aware of the synchronous supporting CTS instances

• The load balancer loads the profiles from the configured repository into memory

• The load balancer implements the algorithm to determine what instance is capable of
transforming the document. If the request arrives to a failed service, it is redirected to a
similar service which is alive.

• The load balancer filters the list of available CTS servers based on product, to service the
request (e.g. MTS registers in the "rotate image” profile).

3. The load balancer matches the request with the service providers to identify which of them is the
best match. The transform request is sent to the appropriate CTS instance.

4. The transformation occurs.

5. The output file is returned to the client via HTTP or URL.
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Asynchronous and synchronous
transformation
There are two ways to call a service, asynchronous and synchronous. The CTS server processes
transformation requests from web services and others and transforms according to the priority given.

Synchronous requests

The CTS framework is enhanced to support synchronous requests from webservice components in
real-time. The real-time architecture’s fair, concurrent thread model prioritizes CTS tasks to make
efficient CTS calls. The synchronous call returns a request immediately by bypassing the repository
queues through the transformation web service layer. A client application requesting real-time
transformation may do so according to the following content matrix:

• File System Input, Repository Output

Source document is provided from client’s file system and the target output is available in the
repository.

• File System Input, File System Output

Source document is provided from client’s file system and the target output is available in the
client machine.

• Repository Input, Repository Output

Source document is provided from the repository and the target output is available in the
repository.

• Repository Input, File System Output

Source document is provided from the repository and the target output is available in the client
machine.

In a ’File System Input, Repository Output’ and ’File System Input, File System Output’ real-time web
services request, the source file can be either a binary or it can be a URL content (a valid URL either a
FILE/HTTP protocol) which can be accessible from the CTS server machine.

Failover is only invoked if a process is incomplete or interrupted; otherwise the middle tier resubmits
the request to another running instance that can handle it.

CTS asynchronous architecture

An asynchronous request interacts with DFC, which in turn interacts with Content Server to generate
transformation queue items. An asynchronous request leverages CTS architecture. The CTS instance
polls the queue item and performs the transformation. The result is stored in the repository.
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Deploying CTS WebServices in a supported
application server
For instructions on how to deploy CTS WebServices, please consult the Installation Guide for your
Content Transformation Services product

Configuring CTS WebServices
There are configuration elements for CTS WebServices located in the WebServerService.xml file:
(%CTS_HOME%\config\WebServerService.xml).

The following elements are used to control the number of real time requests CTS will allow. The
"occupancy” information is relative to these configuration elements.

The following two lines control the maximum number of threads working on transformations and the
sign-off limit beyond which CTS will not accept more real-time requests:
<ServerProperty Key="maxWorkingThreads" Description="Number of working threads"
Type="Integer" Value="3"/>
<ServerProperty Key="thresholdForSignOff" Description="Threshold for maxium number
of requests signed off" Type="Integer" Value="3"/>

Below are configuration elements for monitoring real-time jobs. Any job spending more time than
TPMMonitorMaxTaskJobTime will be considered as hanging and will trigger a CTS restart:
<ServerProperty Key="TPMMonitorMaxTaskJobTime" Description="Maxium allowed task
running time (minutes)" Type="Integer" Value="90"/>
<ServerProperty Key="TPMMonitorSleepTime" Description="Sleep time for tasks monitor
(minutes)" Type="Integer" Value="30"/>
<ServerProperty Key="TPMForceJvmExit" Description="Option to force the JVM exit -
when restarting" Type="Boolean" Value="10"/>

CTS WebServices log file
The CTS WebServices log files are located at %CTSWS_HOME%\cts_ws\logs. The log file is created
once the first request is serviced from the client.
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Chapter 9
WorkingWith the CTS Activity Template
in Documentum Process Builder

The CTS Activity Template allows users to add a transformation as part of a workflow process. The
CTS Activity Template is available for use with Documentum Process Builder.

See the Installation Guide for your Content Transformation Services product for instructions on
installing and configuring the CTS Activity Template.

The following section is meant to supplement — not replace — the information in the Documentum
Process Builder documentation set. You should be familiar with the Documentum Process Builder
application and have access to documentation before proceeding with the tasks in this section.

Any user profile for Content Transformation Services can be used with the CTS Activity Template.
However, keep in mind that if a profile contains user-defined parameters, these parameters cannot be
exposed within the workflow.

Using the CTS Activity Template
This section describes the CTS Activity Template and the special workflow parameters associated
with it. You will also find the procedure to add a transformation to a business process using the
Activity Inspector.

In Documentum Process Builder, activities are the tasks that comprise the workflow. Most of the
configuration of the workflow relates to configuring its activities. You configure activities using
the Activity Inspector.

The Activity Inspector has several tabs, each corresponding to one aspect of activity configuration.
When you select the CTS Activity Template, the following tabs are available:
• The Properties tab sets the priority for automatic activities and lets you provide instructions for
manual performers.

• The Performer tab enables you to select who performs the activity and what actions the
performers have available to them.

• The Trigger tab settings determine when the activity starts.

• The Timers tab sets warning timers to take action if an activity does not start or is not completed
within a designated amount of time.
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• The Notification tab specifies whether to notify the workflow supervisor when certain system
events occur.

• The Display tab controls how the activity appears in the visual display of the process template.

• The CTS Parameters tab enables you to select a transformation and set the options relating to
the transformation.

The Documentum Process Builder User Guide describes all of these tabs – with the exception of the CTS
Parameters tab – in the "Working with Activities” chapter. The following procedure describes how to
add a transformation to a business process using the CTS Parameters tab in the Activity Inspector.

To add a transformation to a business process:

1. Double click the CTSActivity node to open the Activity Template Inspector dialog.

2. Select the CTS Parameters tab.

3. Enter Package(s) for the workflow.
This parameter allows you to select from the packages attached to the process template which
will be processed by the CTS Activity. By default, this selection is empty and CTS Activity will
ignore ALL packages in the workflow. You must add a package if you need it to be processed
by CTS Activity.

4. Select Yes if you want to process workflow attachments with the CTS Activity.

5. Choose a transformation profile from the Profile Name list box.

6. Select the output format for the transformation from the Target Format list box.

7. Enter a rendition description, if desired.

8. Set this transformation as the default proxy, if desired, by choosing the Yes option.

9. Save this transformation, if desired, by choosing the Yes option.

10. Click Apply to save your updates without closing the Activity Inspector, or click OK to save
your updates and close the Activity Inspector.
Consult the Documentum Process Builder User Guide for further instructions on how to use the
workflow feature.

To save a new activity template to the repository:

1. From the Tools menu, select File > Save.
The Save Process Template dialog appears showing the file structure of the repository.

2. Enter a name for the new activity template in the Name text box.

3. Select Create new folder for associated items, if required.

4. Click OK.
The system saves the new workflow template.

5. The Validate Template dialog box appears confirming the workflow has been saved. The dialog
box asks if you would like to proceed to validate the template. Click OK.
If validation fails, a dialog box appears telling you so. Click the Details button to see the error
that prevented validation. If the validation is successful, a red check mark appears next to the
activity template icon in the Activity Templates window.
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6. The Install Template dialog box appears confirming the workflow has been validated. The dialog
box asks if you would like to proceed to install the template to make it available to all users.
Click OK.
If the Install option is unavailable, it means the template is currently installed or you don’t
have permission to install. If the installation is successful, an arrow appears next to the activity
template icon in the Activity Templates window.

7. A dialog box appears to confirm the installation of the template and its activities. Click OK.

To uninstall an activity template:

1. From the Tools menu, select Activity Template > Uninstall.
You can only uninstall if the template is in the installed state and you have Write permission.
If the template is successfully uninstalled, the arrow next to the template icon (representing
installed state) is replaced with a red check mark (representing validated state).

To start a workflow:

When you start a workflow, you select the activity template that includes the sequence of tasks to be
performed and you attach files which are supported by the CTS profile used in the workflow.

1. See the EMC Documentum Digital Asset Manager User Guide for instructions on how to start a
workflow.

To create a new object for transformation output:

1. Double click the CTSActivity node to open the Activity Template Inspector dialog.

2. Select the CTS Parameters tab.

3. See To add a transformation to a business process:, page 106 for instruction on adding a
transformation to a business process.

4. Select Yes to create a new object.

5. Enter a name for the new object in the New Object Name field.
If nothing is entered, it will default to the name of the source object.
The value can include variables. For example, "${source_name}_sample.${target_
format}”. Supported variables are ${source_name}, ${profile_name}, and ${target_format}.

6. Select a repository location for the new object in theDestination Folder field or type in a path to a
repository folder in the Type in Path to Folder field.
If nothing is entered, it will default to the user’s cabinet.
Locations with an object ID (selecting a location with a repository browser) takes precedence. If a
location is typed in it will be used only if the object ID is missing.

7. Select a type for the new object.
If nothing is entered, the value will default to dm_document.
Valid values are:
• "${source_type}” – (var) the type of the source document will be used

• "dm_custom_Type” – (literal) this custom type will be used

8. Enter the relation to the source file in the Relation to Source field.
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The relation must be present in repository.

9. Enter the ACL Name for the new object in the New Object ACL Name field.
Valid values are the name of the ACL or variable ${source_ACL}.

10. Enter the ACL Domain for the new object in the New Object ACL Domain field.
Valid value is the name of the ACL domain.

11. If you want the new object to be deleted in case of error during transformation, select Yes. The
default value for this option is Yes.

12. Click Apply to save your updates without closing the Activity Inspector, or click OK to save
your updates and close the Activity Inspector.
Consult the Documentum Process Builder User Guide for further instructions on how to use the
workflow feature.

108 EMC Documentum Content Transformation Services Transformation Suite Version 6.7 Administration Guide



Chapter 10
Troubleshooting

This chapter provides troubleshooting information for errors encountered from various elements of
Content Transformation Services products. In addition, consult the Content Transformation Services
Transformation Suite Installation Guide for additional information regarding items that can affect the
installation of your products. Also see the Release Notes document for your product, which contain
additional information regarding limitations and known bugs.

This chapter contains the following sections:
• Troubleshooting tips common to Content Transformation Services products, page 109

• Troubleshooting tips specific to Document Transformation Services and Advanced Document
Transformation Services, page 119

• Troubleshooting tips specific to Media Transformation Services, page 122

• Troubleshooting tips specific to Audio/Video Transformation Services, page 125

Troubleshooting tips common to Content
Transformation Services products
The following troubleshooting tips and topics are general to all or multiple Content Transformation
Services products.
• Preserving temporary or intermediate files to debug a problem, page 110

• Error events and log files, page 111

• A transformation request fails, page 111

• A profile error occurs, page 111

• Cannot add a rendition to a particular format, page 112

• Server cannot log in to the repository, page 113

• Content Transformation Services fails to function, page 113

• Locating application server working folder, page 114

• CTS Administration Agent gives AGENT_INACCESSIBLE message, page 114

• CTS fails to transform any document to PDF (using Tools->Transform) that is imported to a web
cabinet as WP admin user, page 114
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• CTS is not responsive after a set of transformations, page 115

• Manual re-configuration of CTS instance if the repository is deleted, page 115

• If Office to PDF transformation fails, page 117

• Restart CTS service if profiles are modified, page 117

• Incorrect error message is displayed when using the wrong version of a rendering application,
page 117

• Rendition failures due to expired login tickets, page 118

• CTS Queue Item Cleanup — Pre-Processing delay, page 118

• After restarting Content Server, CTS product throws a "server communication failure” exception,
page 118

Preserving temporary or intermediate files to debug a
problem

There is a configuration option to preserve temporary or intermediate files. This configuration should
only be used when debugging a problem and disabled as soon as it is no longer required.

The configuration can be overwritten (when "false”) via profile but only in XTS. For the profile, the
values are:

0 – No (do not keep temp files)

1 – Yes (keep temp files)

2 - Error (keep temp files only when there was an error)

The configuration element is in CTSServerService.xml (%CTS_HOME%\Config):
<KeepTempFiles>NO</KeepTempFiles>

By switching this value to YES, input files as well as plug-in results will not be deleted after a
transformation. Also, this value can be overwritten by a profile parameter:
<Parameter name="keep_temp" label="Keep temporary files" controltype="list"
datatype="string" default="0" isRequired="false">
<ValueList>
<Value label="No">0</Value>
<Value label="Yes">1</Value>
</ValueList>
</Parameter>

The output and source files can be found at the following locations:
• for outputs — %CTS_HOME%\cache

• for source files — %CTS_HOME%\docbases\<docbase_name>\config\temp_sessions

Note: The default location for %CTS_HOME% is C:\Program Files\Documentum\CTS

Note: To reflect changes made to CTSServerService.xml, CTS services must be restarted.
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Error events and log files

Any time a Content Transformation Services product fails to process a particular item, it queues an
event (dm_mediaserver_error) to the Inbox of the repository user defined as the system operator in
the server configuration file. The first step in troubleshooting is to check the system operator’s Inbox
for any messages that might explain the error.

Additionally, review the CTS_Log.txt log file. This log file contains errors and exceptions that are
specific to the server. The default location of the log file on the Content Transformation Services
product host, is in the following directory:
%CTS_HOME%\logs

Plug-in error exceptions are sent to individual log files that are specific to each plug-in. These plug-in
log files allow you to quickly troubleshoot exceptions that are specific to each plug-in. For example,
errors relating to the IMG plug-in are found in the IMG_Plug-in_Log.txt log file.

The plug-in log files are located in the %CTS_HOME%\logs directory on the Content Transformation
Services product host. The Image3 log file, IMAGE3_log<number>.txt, is located in the same
location.

Note: If separate logging is enabled, log files will be in the %CTS_HOME%\docbases\<docbase
name>\config\logs folder. Otherwise, they are in the main logs directory at %CTS_HOME%\logs.

A transformation request fails

Occasionally, a transformation request may fail to process, or may process incorrectly. Typically, an
examination of any error messages will indicate the problem.

The following actions can be performed to determine the cause of a transformation request failure.

To troubleshoot the failure of a transformation request:

1. Check for error messages in the system operator’s Inbox indicating that the source file may not
adhere to system specifications. For example, the file may be corrupted, or compression or other
similar features (such as codec) of the file may not be supported by the Content Transformation
Services product.

2. Check that disk space and memory on the Content Transformation Services server host, and the
Content Server host, is sufficient to handle the requested file transformation.

3. Restart the Content Transformation Services server host and attempt the transformation again.
Restarting the server will not affect the queue.

A profile error occurs

Errors related to profiles may occur. For example, if a profile was edited and updated manually,
there may be issues with the XML file.

There are a number of ways to determine the cause of a profile error.
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To identify the cause of a profile-related error:

1. Check the Inbox of the system operator for error messages. Error messages here may indicate
the cause of the error.

2. Check the CTS_log.txt file log file or the main Documentum log file, log4j.log, for
exceptions.

3. If you suspect the profile itself to be the cause of the error, use Documentum Administrator to
make sure you have three folders in the repository for profiles:
• /System/Media Server/Profiles

• /System/Media Server/System Profiles

• /System/Media Server/Command Line Profiles

These folders should be created when you install a Content Transformation Services product.
Make sure the profile is in the correct folder.

4. Make sure that the command-line file referenced by the profile (dm_media_profile object) exists
in the appropriate folder (above) and that the name in the profile is identical to the actual
file name. For example, if a dm_media_profile object resize contains the following link to its
command-line file:
/System/Media Server/Command Line Profiles/resize.xml

make sure the command-line file used by the resize object is called resize.xml.

5. Make sure the ProfileSchema.dtd is stored in the repository folder:
/System/Media Server/Profiles

6. If a new user profile is not appearing in the WDK application, but the log file indicates that
the profile was successfully imported, ensure that the following tags appear in the profile file
(typically after the <Formats> section):
<Filters>
<Filter name="CTSProduct" value="MTS" />
<Filter name="Visibility" value="Public" />
</Filters>

7. Restart the Content Transformation Services product server.

Cannot add a rendition to a particular format

If a Content Transformation Services product cannot add a rendition to a particular format, first
check the Inbox of the system operator for error messages, and then check the CTS_log.txt file.
Look for a detailed message that describes the problem. For example, the message "Object with
id=...does not exist” would indicate that the object was deleted from the repository before the server
could add a rendition to it.

112 EMC Documentum Content Transformation Services Transformation Suite Version 6.7 Administration Guide



Troubleshooting

Server cannot log in to the repository

A Content Transformation Services product connects to the repository using a repository SuperUser
account. If the Content Transformation Services product server cannot log in to the repository, ensure
that a valid repository SuperUser is identified for the product to use.

To identify the cause of a Content Transformation Services server not logging in
to the repository:

1. Make sure that the repository is running.

2. Check your network connections.

3. Check that the Connection Broker is running.

4. Check that the dfc.properties file points to the Connection Broker that recognizes your
repository.

5. Log in to the Content Transformation Services product host as an administrator.

6. Open the Content Transformation Services product’s service directory, located in the directory:
%CTS_HOME%\config

7. Open the SessionService.xml file in any text or XML editor.

8. Check the values of the MediaServerName attributes userName and passwordFile of the Content
Transformation Services product’s element:
<CTSServer AttributeName="userName" AttributeValue="<admin_user"/>
<CTSServer AttributeName="passwordFile" AttributeValue="C:\
PROGRA~1\DOCUME~1\CTS\docbases\<repository_name>\config\pfile\
mspassword.txt"/>

9. Make sure you have configured the SessionService.xml file to the proper user in the
repository who has SuperUser access. If necessary, check with the repository administrator to
verify user name and password information.
For more information on the repository user name and password, see Chapter 2, Administering
and Configuring Content Transformation Services Products Through Documentum
Administrator.

10. Save and close the SessionService.xml file.

11. Restart the Content Transformation Services product server and/or the repository.

Content Transformation Services fails to function

If Content Transformation Services fails to function and you receive an error message when
attempting transformations, the error may occur if the Global Registry does not have a Content
Transformation Services product (Rich_Media_Services and Transformation DAR files) configured
against it. The Global Registry is a common repository where commonly used DAR files are installed.

Ensure Rich_Media_Services and Transformation DAR files are run against the Global Registry
repository. See instructions in the Content Transformation Services Transformation Suite Installation Guide.
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Locating application server working folder

If while configuring CTS Webservices, you are unable to locate the current working folder in which to
place the transformation.properties file, perform the following steps:

• Perform any real time request (and let it fail).

• Check the log file for the location of the folder.

The log file displays the expected location of the transformation.properties file.

• Make sure the transformation.properties file is in the correct folder.

CTS Administration Agent gives AGENT_
INACCESSIBLE message

If the CTS Administration node in Documentum Administrator (DA) is showing an
AGENT_INACCESSIBLE message, it indicates that DA was unable to connect to the agent. This
could be as a result of a number of reasons:

1. The server method on the Content Server is not running.

Check the service on the Content Server machine. There should be a service called Documentum
Java Server Method. Ensure that is started/running.

2. The CTS Administration Agent is not running.

There is a service called Documentum CTS Admin Agent on the CTS machine for the agent. If this
service is running, you should be able to ping the agent by opening your browser and pointing it
to http://machinename:<port>/CTSAgent/CTSAgent (the default port is 9095). It should respond
with a page saying "Content Transformation Services Agent" if it is running.

If the Admin Agent is not running, see Starting and stopping the CTS Administration Agent,
page 22 to start the CTS Admin Agent.

3. The server method on the Content Server is not there.

You can look for the server method using Documentum Administrator (Administration > Job
Management > Methods). Do a search for CTSAdminMethod. There should be one result if it is
a version 5.3 or higher repository.

4. There is no space left on the CTS Administration Agent machine.

Check the machine to ensure there is available space.

CTS fails to transform any document to PDF (using
Tools->Transform) that is imported to a web cabinet as
WP admin user

A transformation request reaches the CTS server but fails with an exception.
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This occurs because WP Documents work with ’application_code’. So any session that does not have
any application_code associated with it will be treated as a Read only session.

Workaround: In the dfc.properties files, you can supply dfc.application_code=dm_wcm. This will
ensure all sessions created will have application_code associated with it.

CTS is not responsive after a set of transformations

CTS is not responsive after a set of transformations and does not poll new queue items from the
repository, even if the QueueProcessorContext threads are active and running.

The issue happens when CTS fails to find the cts_resources.properties and
dam_resources.properties files under the %DFC User Directory%\config folder. This
is fixed so that during startup, CTS checks to see if these files are available in the specified folder,
and if not found, will throw an exception in the CTS_log.txt file and stop the service. The log file
will give more information about the expected location of these files. This issue normally happens
if CTS is installed in a ’non-default’ location.

For older version of the products, this is how to troubleshoot the issue:
• Check to see if there is a stderr.log file created under %CTS%\config folder or perform a
search on the host for this file.

• If the file has any exceptions logged, there could be an issue:
java.lang.RuntimeException: cts_resources.properties file not found:
C:\Documentum\CTS\lib\documentum\config\cts_resources.properties (The system
cannot find the path specified)

• Place these files under the folder specified, and then restart the CTS services.

The issue occurs mainly because the system is not getting the correct "DFC User Directory"
location through the dfc call. This is something configured in the dfc.properties file either
through dfc.data.dir or dfc.user.dir property. In case these entries are missing in the
dfc.properties file, DFC will be using the ’current working directory\documentum’ as the dfc
user directory.

Manual re-configuration of CTS instance if the
repository is deleted

If a repository configured with a Content Transformation Services product is permanently
unavailable, some manual re-configuration is necessary. For example, if the repository cannot be
recovered after a crash, or if the repository is deleted without removing all instances of CTS products,
this procedure is required. Without manual re-configuration, the Content Transformation Services
product fails to start for all repositories that the CTS server was configured against, not just the
deleted repository. You will see the following error in the CTS_log.txt file:
11:28:08,406 INFO [ main] CTSServerHandlerImpl - ***************
Content Transformation 6.5 - Release Build 0.134 ICTSService Framework
startup initiated. ***************
11:28:08,718 ERROR [ main] CTSServerHandlerImpl - Unable to start
the default handler.
com.documentum.cts.exceptions.internal.CTSServiceManagerException:
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Unable to start the default handler.
Cause Exception was: A new instance of ICTSService with SUBTYPE =
CTSPLUGIN could not be created
com.documentum.cts.exceptions.internal.CTSServiceException: Unable
to start the default handler.
at com.documentum.cts.impl.services.CTSServiceBaseImpl.startAll
(CTSServiceBaseImpl.java:930)
at com.documentum.cts.impl.services.CTSServiceBaseImpl.start
(CTSServiceBaseImpl.java:565)
at com.documentum.cts.services.CTSServiceManager.getServiceBySubType
(CTSServiceManager.java:545)
at com.documentum.cts.impl.services.ctsserver.CTSServerHandlerImpl.
getMediaPluginHandler(CTSServerHandlerImpl.java:1074)
at com.documentum.cts.impl.services.ctsserver.CTSServerHandlerImpl.
start(CTSServerHandlerImpl.java:541)
at com.documentum.cts.impl.services.CTSServiceBaseImpl.startAll
(CTSServiceBaseImpl.java:925)
at com.documentum.cts.impl.services.CTSServiceBaseImpl.start
(CTSServiceBaseImpl.java:565)
at com.documentum.cts.services.CTSServiceManager.registerServices
(CTSServiceManager.java:268)
at com.documentum.cts.services.CTSServiceManager.bootstrapServiceFramework
(CTSServiceManager.java:161)
at com.documentum.cts.services.CTSServiceManager.getInstance
(CTSServiceManager.java:118)
at com.documentum.cts.services.ctsserver.CTSServerStartup.main
(CTSServerStartup.java:107)

To fix this, perform the following procedure on the Content Transformation Services product host:

1. Navigate to %CTS%\config (for example, C:\Program Files\Documentum\CTS\config).

2. Make a backup copy of the following files:
• CTSProfileService.xml

• CTSServerService.xml

• SessionService.xml

3. In any text or XML editor, open the CTSProfileService.xml file and remove the entire
<ProfileManagerContext> tag for the repository that is no longer available.

4. In any text or XML editor, open the CTSServerService.xml file and remove the entire
<QueueProcessorContext> tags for the repository that is no longer available. There are two of
these tags for each repository that has been configured, so you will need to remove both entries
for the repository that is no longer available.

5. In any text or XML editor, open the SessionService.xml file and remove the entire
<LoginContext> tag for the repository that is no longer available.

6. Delete the folder for the repository that is no longer available under %CTS%\docbases (for
example, C:\Program Files\Documentum\CTS\docbases).

7. Open the Windows Registry Editor (go to Start > Run > regedit).

8. For all Content Transformation Services products installed, delete the folder with the repository
name that is no longer available under:
HKEY_LOCAL_MACHINE\SOFTWARE\Documentum\CTS\<cts_product>\Docbases

For example, the full path for MTS, including the repository name, will appear as:
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HKEY_LOCAL_MACHINE\SOFTWARE\Documentum\CTS\MTS\Docbases\<repository>

9. Stop the CTS service.

10. Delete the CTS log files.

11. Start the CTS service.

If Office to PDF transformation fails

If a Microsoft Office file type (such as Word) to PDF transformation fails, check that the user account
for Content Transformation Services also has the required privileges to start the Microsoft Office
application. If the Content Transformation Services user account does not have privileges to start
Microsoft Word, the transformation process fails.

Also, ensure that after installing Microsoft Office, you start it for the first time and complete the
registration prompt. If this is not completed, a registration prompt appears, preventing the Content
Transformation Services product from completing any transformation requests.

Restart CTS service if profiles are modified

The CTS Service must be restarted if any system profiles are modified. After modifying a system
profile (such as register), CTS must be restarted because the system profiles are cached during CTS
startup.

Services are restarted using the Windows Services utility, found at Start > Settings > Control Panel
> Administrative Tools > Services.

Incorrect error message is displayed when using the
wrong version of a rendering application

When the wrong version of a rendering application is installed, the transformation request will fail
and the user is notified. For example, if the source document is in Word 2010 but Word 2007 is
installed on the server, the log file should report the correct reason for the transformation failure.
Instead, the log file reports this type of error message:
11:00:29,398 INFO [ Thread-17] AdvancedPDFProcessor -
Result for job: 82ed4941-1cfc-481a-8ca4-339500b61d78\1197460 :
<?xml version=”http://adlibsys.com/webservices”>
Detail log file doesn't exist.</string>

If you receive this type of message, compare the version of the rendering application to the version
for the source document. Install the corresponding version of the rendering application to ensure
successful transformations.
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Rendition failures due to expired login tickets

In some cases, users may experience rendition failures resulting from expired login tickets. The
following error message appears in the log file:
[DM_SESSION_E_START_FAIL]
[DM_SESSION_E_LDAP_AUTHENTICATION_FAILED]
[DM_SESSION_E_LDAP_BIND]

A KeepSessionTimeOut node exists in the SessionService.xml file, to prevent the caching of
login tickets.

However, if the KeepSessionTimeOut node is changed from its default of 0, this error may occur.
Ensure that the value for the KeepSessionTimeOut node is less than the ticketed session expiry timeout
value in the server.ini file for a given repository.

CTS Queue Item Cleanup — Pre-Processing delay

If a delay in starting up the Pre-Processing becomes noticeable, it can be fixed by
updating the markerInterval entry to have the same or lesser value of queueInterval in the
CTSServerService.xml file:
<CTSServer AttributeName="markerInterval" AttributeValue="10"/>
<CTSServer AttributeName="queueInterval" AttributeValue="10"/>

After restarting Content Server, CTS product throws a
"server communication failure” exception

After Content Server is restarted, CTS throws "server communication failure" exception and has to
be restarted to work. Configuration options are available to help improve the CTS response rate for
reconnecting if the Content Server is restarted.

Note: Try updating only the CTS host first, then the Content Server host if necessary.

There are two main configuration elements:
1. Add the following to the dfc.properties file:

dfc.session.keepalive.enable = true

2. Add the following registry entry:
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameter\KeepAliveTime

and set the DWORD value to 300000(Decimal)

Two additional operating system settings to consider adjusting are Keepalive interval and
Keepalive retry

Note: ’Keepalive’ is a networking concept, not a Documentum feature. More details on how
these setting work and how to set them can be obtained from operating system documentation or
other resources.
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Troubleshooting tips specific to Document
Transformation Services and Advanced
Document Transformation Services
The following troubleshooting tips and topics are specific to Document Transformation Services
and/or Advanced Document Transformation Services.
• Resolving page numbering problems with rendered Office 2007/2010 documents (DTS and
ADTS), page 119

• Resolving problems with autoshape color in rendered Office 2007 documents (DTS and ADTS),
page 120

• For merge VD to PDF, if show relationship between parent and child is set to "no", then no
TOC/bookmarks are created even though TOC is enabled (ADTS), page 120

• Word crashes when converting a file to PDF (DTS & ADTS), page 120

• Hyperlink colors not appearing as expected, page 121

• PowerPoint to PDF Transformations lose the shadows on objects, page 121

• Users with version permission get Inbox notification on legacy transformations, page 121

• When PDF files convert to a merged PDF, Japanese characters illegible in TOC page of the merged
PDF, page 122

Resolving page numbering problems with rendered
Office 2007/2010 documents (DTS and ADTS)

If you are experiencing problems with page numbering while rendering Office files using Office 2007
or 2010, you may need to set a registry entry on the DTS or ADTS host.

For example, if the file’s page numbering had been set to 1 of 10, 2 of 10, 3 of 10, etc., when the file is
rendered, the page numbering will appear as 1 of 1, 2 of 2, 3 of 3, etc.

Adding the registry key included with the installation may repair problems with page numbers
in rendered Office files. Navigate to the %CTS%\AdlibSetup directory and double-click the
PrintInBackground.reg file to apply the registry update.

PrintInBackground – Microsoft documentation states: "Explicitly sets the Print in Background option
in MS Word to be enabled or disabled when printing. The Automatic setting will use the option as
it has been configured in MS Word.” If this key is not added the default is disabled. If it is set to 1
then it is enabled.
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Resolving problems with autoshape color in rendered
Office 2007 documents (DTS and ADTS)

Word documents containing an AutoShape image that has been painted with a color or grayscale
may result in a PDF containing a checked image (instead of the original color/grayscale).

Adding the registry key included with the installation may repair problems with page numbers
in rendered Office files. Navigate to the %CTS%\AdlibSetup directory and double-click the
SimPostScript.reg file to apply the registry update.

Simpostscript – Microsoft documentation states: "This option is useful for printing Wordarts and
semi-transparent backgrounds using OfficeXP.” If this key is not added then the default is Automatic.
When it is set to 0 this option is disabled.

For merge VD to PDF, if show relationship between
parent and child is set to "no", then no TOC/bookmarks
are created even though TOC is enabled (ADTS)

If the relationship between parent and child is set to "yes", the TOC is created according to the value
inputted by the user through the WDK client (enabled/disabled).

The issue happens only if BOTH of the following two condition applies:
• The parent file does not have bookmarks info in it.

• ’Show virtual doc relationship in TOC’ profile parameter flag is selected as ’No’.

In the normal case, if the parent file has bookmark information in it, all those parameter permutations
works as expected.

This scenario works only if the parent file has bookmark information in it to generate the TOC. If the
parent file does not have bookmarks info in it AND if ’Show virtual doc relationship in TOC’ profile
parameter flag is selected as ’No’, the TOC will not be created.

Word crashes when converting a file to PDF (DTS &
ADTS)

The following may help if Microsoft Word crashes when converting a file to PDF.

Caution: Be sure to backup your registry before making any changes.

1. Open the Windows registry on your DTS or ADTS host.

2. Navigate to:
HKEY_LOCAL_MACHINE\SOFTWARE\Adlib\Adlib Express\1.0.0\Native App Settings\
Microsoft Word

120 EMC Documentum Content Transformation Services Transformation Suite Version 6.7 Administration Guide



Troubleshooting

3. Edit the following:
• Name: ConvertToBlackTimer

• Type: DWORD

• Value: 20 (decimal)

4. Save and close the registry.

Hyperlink colors not appearing as expected

If a command line file or profile is customized to specify a certain hyperlink color, be sure that the
color value entered is fully supported.

For example, the command line file document_to_pdf_adts.xml is customized to include the
following:
<JOB:HYPERLINKS ENABLED="Yes" CREATECONTENTHYPERLINKS="Yes">
<JOB:HYPERLINKAPPEARANCE DISPLAYCOLOR="16711680" />
<JOB:HYPERLINKS/>

However, when the object is rendered, portions of the hyperlink appear in a different color than that
specified (for example, the page number is black instead of blue).

In this case, the display color entered (that is, 16711680) is a known issue where Microsoft Word
cannot apply the specific color to the entire hyperlink. Selecting a different display color value
(for example, the slightly different 16646144).

You may also try adding the following entry to the command line file, specifically for Microsoft
Word files:
<JOB:MSWORDHYPERLINKS DISPLAYCOLORMODE="Defined" DISPLAYCOLOR="16646144"
DISPLAYSTYLEMODE="Defined" DISPLAYSTYLE="None" HYPERLINKDESTINATION="Page"/>

PowerPoint to PDF Transformations lose the shadows
on objects

When converting a PowerPoint that has objects that have shadows to PDF, the result does not
contain the shadows.

Within PowerPoint, there is an Advanced option to Print High Quality. If you select this option in
PowerPoint, and save the presentation, then the rendered PDF will have the shadows as expected.

Users with version permission get Inbox notification
on legacy transformations

To fix this problem perform the following procedure:
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1. Check out the legacy_to_pdf system profile from the repository, in the folder:
\System\Media Server\System Profiles.

2. Modify ALL of the innerprofile entries to have an additional innertokenmapping tag for
"add_rendition_properties" token in it as follows.
<InnerProfile path="/System/Media Server/System Profiles/document_to_pdf"
waitOnCompletion="true" useTargetFormat="true">
..
..
<InnerTokenMapping LocalProfileToken="false" InnerProfileToken=
"add_rendition_properties" Literal="true"/>
</InnerProfile>

If LocalProfileToken is set to false, properties will NOT be added to the rendition. The default
value will be true. If the tag is missing or if the value is "true" properties will be added. If the user
has only VERSION permission, set this attribute value to "false" so that at least the renditions will
be created as in previous versions.

3. Check in the legacy_to_pdf system profile.

When PDF files convert to a merged PDF, Japanese
characters illegible in TOC page of the merged PDF

Users may transform a source PDF that has Japanese characters in the file name or PDF Bookmark by
using the Merge Documents To PDF or Merge Virtual Document Elements to PDF profiles. The result
is that Japanese characters are garbled in the TOC page of the resulting merged PDF.

Workaround: When using Japanese characters in Headers, Footers, Watermarks or TOC’s, you need
to use the FONTNAMEEXTENDED attribute to specify a font that is compatible with the character
set you are using. Please refer to the following example:
<!-- TOC styles are specific settings with a keyword to be used within the TOC -->
<JOB:TOCSTYLES>
<JOB:TOCSTYLE NAME="Header" FONTNAMEEXTENDED="Ms Mincho" FONTSIZE="16" />
<JOB:TOCSTYLE NAME="Item" FONTNAMEEXTENDED="Ms Mincho" FONTSIZE="14" />
</JOB:TOCSTYLES>
</JOB:TOC>

Troubleshooting tips specific to Media
Transformation Services
The following troubleshooting tips and topics are specific to Media Transformation Services.
• Media Transformation Server fails to start the PowerPoint plug-ins, page 123

• Processing fails for CR2 and DNG files in a fresh MTS installation but works when CTS is
restarted, page 123

• Transparency in png renditions lost for Illustrator files, page 123

• How to import IPTC data with an image to a rendition, page 123

• How to preserve ICC profiles during transformations, page 124
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• Text wrapping problems with large double byte characters (add text profile), page 124

• Embedding metadata for date datatype other than default, page 124

• Poor quality of PPT renditions in MTS, page 124

Media Transformation Server fails to start the
PowerPoint plug-ins

If the Media Transformation Server fails to start the PowerPoint plug-ins, the following error message
appears:
Unable to instantiate PowerPoint MPI: Can't co-create object

This error may occur if your computer has insufficient Component Object Model (COM)
access permissions, or the COM Default Impersonation Level is set improperly. COM is a
Microsoft-developed software architecture that allows for the creation of component-based
applications.

To configure your COM access settings, see Defining file formats and DOS extensions, page 26.

Processing fails for CR2 and DNG files in a fresh MTS
installation but works when CTS is restarted

When a CR2 or DNG file is imported to the repository using a fresh installation of Media
Transformation Services, the files are not processed. However, the processing succeeds if CTS is
restarted and the import is attempted again.

Transparency in png renditions lost for Illustrator files

PNG renditions made from AI files lose their transparency when using MTS.

For example, backgrounds lose their transparency and appear as white when the images appear on a
webpage that has a non-white background color.

To maintain an image’s transparency remove the -flatten option from the imw command line file.

How to import IPTC data with an image to a rendition

IPTC (International Press Telecommunications Council) data embedded within an image is not
transferred to a rendition upon import.

The EXIF plugin can extract EXIF and IPTC data but IPTC data can only be extracted from jpeg
images. To extract EXIF and IPTC properties and save them as object properties upon import the
following needs to be added to the register profile.
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To enable the extraction to the Documentum Object, the following InnerProfile needs to be added
to the register profile:
<!-- This will extract EXIF and IPTC data and set object properties -->
<InnerProfile useTargetFormat="true" waitOnCompletion="true" path="/System/
Media Server/Profiles/extractExifMetadataToObject">
<InnerTokenMapping Literal="true" InnerProfileToken="overwrite_rendition"
LocalProfileToken="false"/>
</InnerProfile>

How to preserve ICC profiles during transformations

To allow MTS to preserve the ICC profile associated with ICC-aware files (for example, Photoshop
files) remove the following from the Command Line file generating the desired rendition(s):

-strip and +profile icc -profile "doc_token_cmyk_profile" -profile "doc_token_rgb_profile"

Text wrapping problems with large double byte
characters (add text profile)

When double-byte characters are entered and given a large font size using the Add Text profile, some
of the text is lost as it does not wrap.

Embedding metadata for date datatype other than
default

If you want to embed metadata to content for a date datatype and you want to specify a date
format other than the default which is MM/dd/YYYY HH:mm:ss then you need to add an attribute
dateFormat to the MetadataMapper line in the embedMetadataToContent.xml command line file
specifying the format to use. For example:
<MetadataMapper name="date_created" value="cch_photo.date_created" datatype="date"
dateFormat="yyyy-MM-dd" token="doc_metadata_date_created"/>

where cch_photo is the custom type created and date_created is the attribute for the cch_photo type.

Poor quality of PPT renditions in MTS

The low-res proxy and thumbnails renditions of PowerPoint presentations and slides that are
imported and produced using Media Transformation Services do not display the content well. For
example, text may be blurry.

This is due to a limitation with Microsoft product. The patch they provide will not resolve the issue,
because according to the patch, the resolution is dependant on the output file size. So if you need
to get a higher resolution rendition, the image file size needs to be a higher value. This may work
for preview proxies, but not for the regular thumbnails/proxies.
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Troubleshooting tips specific to Audio/Video
Transformation Services
The following troubleshooting tips and topics are specific to Audio/Video Transformation Services.
• Resolving rendition problems with some video formats, page 125

Resolving rendition problems with some video formats

You may experience difficulty with Audio/Video Transformation Services failing to create some
renditions for some video formats. To resolve this issue, make sure you have the correct video codecs
installed on the Audio/Video Transformation Services host.

Each video file uses a particular video codec. A video codec is a technology used for
compression/decompression to reduce the number of bytes consumed by large files. If a given
video file uses a video codec that is not installed on the Audio/Video Transformation Services host,
Audio/Video Transformation Services will not be able to create renditions for that file.

To see which video codec is used for a given file:

1. Select the given video file and right-click it.

2. Click Properties.

3. Select the Summary tab.

4. Under the Video section, you will see the Video Compression property. The value of this
property will tell you which codec is used for this file.

To see which video codecs are installed on the Audio/Video Transformation Services
host:

1. Go to Control Panel > Sound and Audio Devices.

2. Click the Hardware tab.

3. Select Video Codecs from the Devices list box.

4. Select Properties.

5. Click the Properties tab. It will show you the list of codecs installed on that machine.

6. Click Cancel to exit.
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A
activity templates

attach workflow, 107
copying, 106
installing, 106
uninstalling, 107
validating, 106

Admin password, changing, 22, 31
attach workflow

to activity templates, 107
attributes

content_attr_name, 18
content_attr_value, 18
mapping syntax examples, 70
passing to plug-ins, 68
richmedia_enabled, 12
transferring from document to PDF, 68

to 69
viewing in PDF renditions, 70

B
batch files, 22
BOCS

configuring, 41

C
caching configuration, 39
CenterStage, CTS enabled, 12
command-line files, 111
configuration objects, 70
configuring

caching, 39
changing login user name, 21
changing the logging level, 21
changing the maximum number of

queue items, 22
changing the notification setting, 21
changing the polling interval, 21
changing the queue item expiry, 22

changing the repository, 26
changing the system operator, 21
CTS for BOCS, 41
CTS load balancer, 44
CTS products using Configurator, 26
for distributed environment, 41
queue pre-processor, 37
repository, 26

Content Server
integration with Content

Transformation Services, 12
integration with Streaming Server, 13
queue, 12
storage of low-resolution

renditions, 17
storage rules, 13

Content Transformation Monitor
Services, 26

Content Transformation Services
configuring application timeouts, 37
description, 11
error message, 113
fails to function, 113
global flag, 12
integration with Content Server, 12
request priority, 12

content_attr_name attribute, 18
content_attr_value attribute, 18
creating

PDF renditions, 61
storyboard renditions on import, 61
thumbnail renditions on import, 61

CTS
starting, 26
stopping, 26

CTS Activity Template
create new object on

transformation, 107
document transformation, 106
Documentum Process Builder, 105
installing, 105
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workflow parameters, 105
working with, 105

CTS Admin Agent, 22
CTS Reporting Tool, 31

disable, 32
enable, 31
viewing reports, 32

CTS Service
changing user, 29

CTS WebServices
architecture, 101
asynchronous transformation, 103
configuring, 104
deploying, 104
DFS, 101
log file, 104
Operations, 101
Profile service, 99 to 100
synchronous transformation, 103
Transformation service, 99 to 100
what are, 99

CTS_Log.txt, 111

D
DAM. See Digital Asset Manager
data model of media objects, 13
deploying CTS WebServices instance

JBoss, 104
WebLogic, 104
WebSphere, 104

details of a CTS instance, viewing, 22
DFC, 12
Digital Asset Manager

CTS enabled, 12
distributed environment

configuring, 41
DITA filters

adding new, 90
configuring, 89

dita_transform_chm.xml, configuring, 92
dita_transform_command.xml file, 91
dita_transform_pdf.xml, configuring, 92
dita_transform.xml

adding filters to, 90
dita_transform.xml, configuring, 89
dm_document object, 17
dm_format object, 12
dm_mediaserver queue, 12
dm_mediaserver_error, 111

dm_register_asset, 15
dm_repository_config object, 12
dmi_queue_item object, 15
dmr_content object, 18
DocBook filters

adding new, 93
configuring, 92

docbook_transform_command.xml file, 94
docbook_transform.xml

adding filters to, 93
Documentum Administrator

administrative tasks, 21
configuration tasks, 21
Create New Format Object page, 26
defining file formats, 26

Documentum format mapping, 62
Documentum Foundation Classes. SeeDFC
DOS extensions, 26

E
embed_metadata setting, 66
errors, 111 to 113

log files, 22
receiving, 21
with plug-ins, 111

events, dm_mediaserver_error, 21, 111
extracting

media properties, 18
XMP metadata, 18

F
file formats, 26
files

storage, 12
filters

adding product names, 88
default, 87
definition, 87
for DITA transformations, 89
for DocBook transformations, 92
in source files, 87

format mapping table, 62
formats

rich-media enabling, 62, 79

G
generating

low-resolution renditions, 17
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storyboards, 17
thumbnails, 16

Global Registry
CTS product, 113

I
Inbox notifications, 21, 111

changing in DA, 21
configuring, 27

installing
activity templates, 106
CTS Activity Template, 105

instance details, viewing, 22
IPTC Headers, 19

L
load balancing, 44

configuring, 44
local content

prioritizing, 41
log files, 111

CTS WebServices, 104
viewing, 22

log in, 113
log4j.properties

setting appenders, 39 to 40
logging appenders

setting, 40
logging level

changing, 21
login user, identifying, 21
login_ticket attribute, 70
low-resolution renditions, 12

generating, 17
storing, 17
supported file formats, 17

M
media objects data model, 13
media properties

examples of, 18
extracting, 18
storing, 18

Media WorkSpace, CTS enabled, 12
metadata, 18
modifying

register.xml, 61 to 62, 64
monitor services, 26

multiple servers, 44

N
notifications

changing in Documentum
Administrator, 21

configuring, 27

O
objects

dm_document, 17
dm_format, 12
dm_repository_config, 12
dmr_content, 18
storing, 13

overwriting renditions, 67

P
password, changing, 31
password, changing in Documentum

Administrator, 22
PDF

files, viewing repository attributes, 70
metadata, storing, 66

PDT files
saving, 65

plug-ins
errors, 111
passing attributes to, 68
processing, 15, 18

polling interval, changing, 21
PowerPoint objects, 17
processing files, 15
Profile service

addProfile operation, 100
getProfileById operation, 100
getProfileByName operation, 100
Operations, 100 to 101
removeProfile operation, 100
updateProfile operation, 100
what is, 99

profile_audience filter, 87
profile_os filter, 87
profile_product filter, 87

adding names to, 88
profile_revision filter, 87
profiles, 111

IPTC Headers, 19
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ProfileSchema.dtd file, 88 to 89

Q
queue

managing, 33
object, 12
objects, 11
priority, 12

queue items
changing the expiry, 22
changing the maximum number

allowed, 22
queue pre-processor

manage queue item, 37

R
refreshing server, 22
register.xml, modifying, 61 to 62, 64
registration

description, 14
extracting media properties, 18
generating low-resolution

renditions, 17
generating storyboards, 17
generating thumbnails, 16
XMP metadata, 18

renditions, 112
low-resolution, 17
storage of, 17
storyboard, 17
thumbnail, 16

repeating attributes, 70
replacing previous renditions, 67
repository, 113

adding, 26
changing, 26
config object, 70
removing, 26

request, 12
transcode_content, 19

rich-media enabling formats, 62, 79
richmedia_enabled attribute, 12

S
saving

PDT files, 65
sentby attribute, 70
separators, 70

server
multiple, 44
refreshing, 22
starting, 22
stopping, 22

settings
embed_metadata, 66
logging appenders, 40
storePDTRendition, 65

source documents, 26
starting, 22

Content Transformation Services
products, 26

stopping, 22
Content Transformation Services

products, 26
storePDTRendition setting, 65
storing

objects, 13
PDF metadata, 66
rules, 13

storyboards
generating, 17
multi-page documents, 17
timecode, 17

Streaming Server, 13
system operator user, identifying, 21

T
Thumbnail Server

storing thumbnails, 13, 17
thumbnails

for slides, 17
generating, 12, 16
storing, 13, 17

timecodes, video, 17
timeout interval, 37
transcode_content request, 19
transferring document attributes to

PDF, 68 to 69
Transform DocBook to HTML.xml,

configuring, 92
transformation

automated, 14
extracting IPTC Headers, 19
failure, 111
performing, 11, 19
process, 19
profiles, 20, 111
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request, 12
user requested, 19

Transformation node, 33
Transformation queue

changing queue priority, 34
configuring queue management

fields, 36
deleting queue item, 35
managing, 33
removing queue management field, 36
viewing details of queue item, 35
viewing transformations, 34

Transformation service
addJob operation, 101
cleanUpJobs operation, 101
CTS WebServices, 100
deleteJob operation, 101
getJobInfo operation, 101
importAndAddJob operation, 101
transformJob operation, 101
what is, 100

troubleshooting, 111
with log files, 22

U
uninstalling

activity templates, 107
username attribute, 70
users, changing

for CTS Service, 29
for repository login, 21
system operator, 21

V
validating

activity templates, 106

W
Web Publisher, CTS enabled, 12

X
XMP metadata

extracting, 18
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